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Enterprise Architect allows any number of people to work on models and diagrams simultaneously, in a cooperative and
team effort. The suite of Collaboration tools - introduced in the Available Facilities table - ensure that communications
concerning elements, diagrams, lists and matrices are available in the model alongside those objects, and links can be
created between the communications and the objects via those tools.

The 'Collaborate' panel in the Enterprise Architect Start ribbon conveniently brings these tools together, ensuring that
you are informed about what you need to attend to and made aware of information that is important to your role. The
'Support Collaboration' option in a diagram's properties also keeps you in the flow of a Chat conversation with a user or
user group, or a Discussion concerning an element, whilst you are modeling in diagrams.

Available Facilities

Facility Description

Review Elements These elements enable you to define a formal review of a part of the model, in
particular a small number of elements and/or diagrams. Each element enables you
to define when the review should start and end, and which members of the team are
responsible for performing the review.

Apart from the Review elements themselves, you use these windows to set up and
manage reviews:

e The Discuss & Review window at the 'Review' tab, on which you can join a
review and create new discussion points or responses within that review, on
any element or diagram

e The Reviews view, listing all current and recent reviews of elements

e The Discuss & Review - History window at the 'Reviews' tab, showing the
elements included in a selected review; you can switch to the 'Review' tab of
the Discuss & Review window to show the details of a selected element under
review

Discussions Discussions are grouped threads of conversation concerning an element or diagram
in the model. One user creates a topic of discussion on an object, other users reply
to that topic and to each other's responses, and so a conversation develops.

Discussions are created and managed through these facilities:

e The Discuss & Review window at the 'Discuss' tab, on which you can create a
new discussion or add to an existing discussion on a specific element or
diagram

e  The Discuss & Review - History window at the 'Discussions' tab, on which you
can review the various discussions of elements recorded in the model, for
Today, Yesterday, This Week, Last Week, This Month and Last Month

e The Recently Discussed Elements report, which presents elements that have
been the subject of discussion in the last 7 days (by default; you can change the
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number of days in the 'Search Term' field)

Chats Chats are informal conversations between team members identified by either their
user ID or a Group name. The conversations are not directly linked to any model
structure, and can concern any subject in or outside the model.

Comments Comments are unstructured, ad-hoc notes or reminders lodged against specific
elements by any user. The user can create a comment or add to or edit an existing
comment, or remove the comment.

Diary Enterprise Architect provides a great facility for maintaining a daily diary. You can
record all kinds of ideas, comments, notes, suggestions, events, to-do lists and other
reminders of what you have done or intend to do within the model. This is a great
way to keep the momentum flowing day to day. The facility is simple to use,
allowing you to quickly jot down your thoughts as they occur to you.

Model Library Within the Library you can review and add to a hierarchically-structured repository
of comments, reports, reviews and documents on any feature or aspect of the
project or related projects.

Mail The Model Mail facility provides you with the ability to send, receive and respond
to emails within the project team, under your User Security ID, either as an
individual user or as a member of a group that has a shared mail inbox.

Calendar The Project Calendar allows the team members to record scheduled meetings and
reminders of events for today or any day in the future, and to check for such events
falling due.

Personal Kanban Diagram Within the extensive Kanban facilities, each user can identify their personal Kanban

diagram and display it as a default diagram.

Personal Gantt Chart The Gantt chart facilities include an extracted chart for each user, listing tasks and
showing status as completed or incomplete.

Collaboration in Diagrams

Enterprise Architect has an additional feature that enables you to work on sections of your model in diagrams, and be
notified on the diagram of any posts in relevant Discussions or Chats concerning the elements you are working on. A
floating toolbar against the elements also enables you to instantly access various tabs of the Discuss & Review window,
Chat & Mail window, and the 'Model Message' dialog, displaying posts and messages concerning the selected element.
For more information, see the Collaboration Support in Diagrams Help topic.

(c) Sparx Systems 2025 Page 5o0f119 Created with Enterprise Architect



Teams & Collaboration

2 September, 2025

The Modeling Team
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Enterprise Architect has been built from the ground up as a team modeling platform, and has extensive support for
groups of people working together on the same projects, sharing information, ideas and models. Features in team support
include Baselines, Version Control and a Reusable Asset Service, which protect the valuable modeling assets in a team
environment, plus tools such as a Discussion Forum, Library window and Gantt Charts to facilitate collaboration
between project members. The role-based security system has also been designed to encourage collaboration, allowing
team members to work together confident that there will be no conflicts in accessing or changing model data.

A choice of deployment options will support any team development environment, allowing people to work centrally or
remotely in highly distributed environments. Corporate policy and standards can also be built into the models with the
use of Workflow Scripts. A free 'Lite' version of Enterprise Architect offers team members 'view only' access to their
models, yet also allow them to generate high quality corporate documentation in a wide number of formats to
communicate with people outside the modeling platform.

Overview

Facility

Team Development

-
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e &
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Formal Model Reviews

—

»

Project Management

~~

Project Resources

Glossary
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Description

Set up a collaborative modeling environment, taking advantage of security,
workflow and shared reference data, as discussed in the rest of this topic.

A simple yet effective mechanism for capturing, in real time, reviews of a section
of the model in line with a particular event. Typically, a Project Manager or
coordinator will create a Review element specifically to discuss one or more
elements for a project phase or other category of review, over a defined period.

Explore some of the ways you can manage your project and team within Enterprise
Architect.

Track and manage the people and resources in your project.

Define a common vocabulary between your different teams, ensuring common
understanding.

Page 6o0of119 Created with Enterprise Architect



Teams & Collaboration 2 September, 2025

Task Allocation Assign and Track team tasks in a Gantt View.

Personal Tasks Record and manage your personal tasks within the project.

Model Mail Use Model Mail in the Chat & Mail window to securely communicate with your
team via an internal email system embedded within the model.

(e
'J

Project Calendar Track the deployment of resources, time-frames for tasks, and upcoming project
7= events such as meetings and milestones, in a calendar format.

Use Case Estimation Form an estimate of the complexity of a system and an indication of the effort
required to implement the model.
L
"“h
Library Window Provides access to a team-based library of documents to record and discuss the
_..H,:\ development and progress of the project.

©

Making Project Data Available in a Distributed Environment

Enterprise Architect offers a diverse set of functionality designed specifically for sharing projects in team-based and
distributed development environments; for example: Cloud-based solutions, network deployment of model repositories,
replication and Native/XMI Import/Export.

Applying Security to the Model

User Security is a means of improving collaborative design and development by preventing concurrent editing and
inadvertent model changes by users not designated as model authors.
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Using an Internal Discussion Forum

The Discussions facility provides several mechanisms to support your development team community, generally in
discussing the development and progress of the model across the project, or specifically in discussing individual
elements in the model, the discussions becoming a component of each element.

Building Company Policy and Project Development Guidelines into the Project

You can create workflow scripts that provide a robust approach to applying company policy and strengthening project
development guidelines, by validating the work against the policy and procedures within the model itself.

Standardizing and Re-using Project Data

You can import and export Reference data (including Glossary and Issue information) from .XML files of another
iteration of the same model, or of a different model.
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Typical Project Roles

Enterprise Architect is an effective multi-disciplinary modeling platform that supports common work practices and
provides features to assist the entire spectrum of roles and disciplines across enterprise, business, engineering and
software projects. Each role will typically use different features of the tool. A number of the roles and their
responsibilities that the system supports are outlined here.

You can review a summary of the typical tasks supported for each role, or review the Help topic for the appropriate role
title to explore how Enterprise Architect can assist you in carrying out that role within a model-driven project.

Roles and Responsibilities

Role Responsibilities
Business Analyst Create high-level models of business processes.
Software Architect Map functional requirements, perform real time modeling of objects, design the

Deployment model and detail the deliverable components.

Software Engineer Map Use Cases onto Class diagrams, detail the interactions between Classes, define
the system deployment and define software Packages.

Developer Perform round trip code engineering, including reverse engineering of existing code
and generation of code from Class elements.

Project Manager Assign resources to elements, measure risk and effort, estimate project sizes, and
manage element status, change control and maintenance.

Tester Create test scripts against elements in the modeling environment.
Implementation Manager e Track and assign maintenance-related items to elements within Enterprise
Architect

e Rapidly capture and keep records of maintenance tasks such as features,
changes, documents, issues, defects and tasks

e Trace the maintenance of the items and processes involved in system

deployment
Technology Developer Create customized additions to the functionality already present within Enterprise
Architect.
Database Developer Develop databases, including modeling database structures, importing database

structures from an existing database and generating DDL for rapidly creating
databases from a model.
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Summary of Typical Tasks

Throughout a design and development project there are many different tasks to be performed, which could be carried out
either by one person or - more probably - by members of a team with different responsibilities. In either case, Enterprise
Architect supports most - if not all - of the responsibilities you might have on your project. The descriptions in this topic
identify a number of job roles that the system supports. For those that most resemble your role on a project, refer to the
Help topic for that job title to read a description of how that role might make use of Enterprise Architect, then use the
references within those topics to explore some of the features of importance to the role.

Summary of Typical Job Roles

Most of these roles work with specific types of diagram, so you might want to learn more about diagram types in general
and specific types of diagram in particular.

Several types of project team member might want to generate documentation on their work and report on how the project
is developing and changing. Using Enterprise Architect you can generate project reports in either document or web
format.

Role Responsibilities

Business Analyst For modeling:
e Requirements
e High-level business processes
e Business activities
e  Work flows

e System behavior

Database Developer e Developing databases
e  Modeling database structures
e  Creating logical data models
e  Generating schema

e Reverse engineering databases

Software Architect e  Mapping functional requirements of the system
e  Mapping objects in real time
e  Mapping the deployment of objects

e Defining deliverable components

Tester e Developing test cases
e [mporting requirements, constraints and scenarios
e Creating Quality Test documentation

e Tracking element defects and changes

Software Engineer e  Mapping Use Cases into detailed Classes
e Defining the interaction between Classes
e Defining system deployment

e Defining software Packages and the software architecture

Project Manager e Providing project estimates
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Developer

Implementation Manager

Technology Developer

Notes

Resource Management

Risk Management

Maintenance Management

Forward, reverse and round-trip engineering
Visualizing the system states
Visualizing Package arrangements

Mapping the flow of code

2 September, 2025

Modeling the tasks in rolling-out a project, including network and hardware
deployment

Assigning and tracking maintenance items on elements (issues, changes,
defects and tasks)

For creating or customizing:
UML Profiles

Patterns

Code Templates

Tagged Value Types
MDG Technologies

Add-Ins

e The Corporate, Unified and Ultimate Editions of Enterprise Architect have a User Security feature that can be
applied or turned off; if security is turned on, you need to have the appropriate access permissions to use many of the

facilities

(c) Sparx Systems 2025
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Enterprise Architect

Enterprise Architects can use the tool to create a deep representation of an enterprise, including Business, Information,
Application, and Technology architectures.

You can create Roadmaps as overlays on any diagram type, and capability models can ensure the architectures align with
what the enterprise does. You can create Business, Information, Application, and Technology Architectures, and these
and the teams that create them can be managed through the tool. Architects and other stakeholders can automatically
generate business-friendly publications, including charts and graphs, to visualize critical parts of the architectures.

Enterprise Architect Tasks

Task Detail

Create Strategic Roadmaps Roadmaps guide an organization from its current state to a target state, thus
transforming the enterprise and steering it on a strategic course through a series of
transition states.

Enterprise Architect has productive and flexible roadmap facility, allowing you to
create roadmaps from pre-built model patterns for a solution, segment, and
enterprise architectures. You can develop roadmaps for any architecture artifacts,
including capabilities, applications, and technology items.

Define Business Capability Business Capabilities are the cornerstone for the work carried out by the other

Models architecture domains, including Information, Application, and Technology
Architecture. They provide a way of viewing what the business does or needs to do.
They are considerably easier and less time-consuming to create than business
processes and directly correlate to what the enterprise does.

You can model capabilities using ArchiMate capability elements or UML Activities
and diagrams of nested elements modeling the hierarchal structure of these
all-important business elements. The capabilities can be automatically colored in
two dimensions using dynamic diagram legends.

Catalog Application The Application Architecture provides an essential catalog of the applications in the

Portfolios enterprise describing the work that they do to transform, transmit and store
information. The architecture also describes the interfaces required or provided by
the applications and how the applications interact to carry out the activities
described in the business models, such as the Business Process diagrams.

You can model application portfolios in Enterprise Architect and visualize the list
in various ways, including diagrams, list views, specification manager, and charts

and graphs.
Model Information Information Architecture is key to the success of an Enterprise Architecture
Architectures Program, as information is created, consumed, and destroyed by the components

that make up the other architectures. The information architecture will typically
include a description of the baseline and target architectures, with a series of
transitions defined that can be executed and described on Roadmap diagrams.

Enterprise Architect is a profoundly useful tool for creating and maintaining
information architectures. Its sophisticated and extensive support for standards and
its wide range of tools to support information models, from high-level
classifications and concepts right down to the level of schemas and the elements
and columns that comprise them.

Create Technical Reference The Technical Reference Model (TRM) references generic platform services and
technology elements and acts as a substrate upon which to build a technology
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Models architecture. The TRM provides a set of architectural and solution building blocks
that will ultimately provide the platform for business and infrastructure applications
to deliver the application and infrastructure services.

You can use Enterprise Architect to create any technology model, and you can use
any modeling language to represent the devices, nodes, system software, and any
other technology artifact.

Manage Architecture The governance of the architectures is critical for the success of the program and

Governance the architectures it creates. Regardless of how perfect an architecture is, without the
assurance that the technology staff has implemented it correctly, the vision
expressed in the architecture might not be realized, the promise made to the
stakeholders will be empty, and the business value will never eventuate.

You can use Enterprise Architect to govern and manage your architectural practice
and the architectures it produces, including governance boards, the governance
register, and more.
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Business Analysts

A Business Analyst can use Enterprise Architect to create high-level models of business processes, including business
requirements, activities, workflow, and the display of system behavior.

Using Enterprise Architect, a Business Analyst can describe the procedures that govern what a particular business does.
Such a model is intended to deliver a high-level overview of a proposed system.

Business Analyst Tasks

Task Detail

Model High Level Using Analysis diagrams, you can model the high-level processes of the business.

Business Processes Analysis diagrams are a subset of UML 2.5 Activity diagrams and are less formal

than other diagram types, but they provide a useful means for expressing essential
business characteristics and requirements.

Model Requirements Gathering requirements is typically the first step in developing a solution, be it for
developing a software application or for detailing a business process; it is an
important step in the implementation of a project.

Using Enterprise Architect, you can define the Requirement elements, connect
Requirements to the model elements for implementation, connect Requirements
together into a hierarchy, report on Requirements, and move Requirements out of
model element responsibilities.

Model Business Activities You can use Activity diagrams to model the behavior of a system and the way in
which these behaviors are related to the overall flow of the system.

Activity diagrams do not model the exact internal behavior of the system but show
instead the general processes and pathways at a high level.

Model Workflow To visualize the cooperation between elements involved in the workflow, you can
use an Interaction Overview diagram, which provides an overview of sub activities
that are involved in a system.

Display System Behavior In displaying the behavior of a system as a Use Case diagram, Enterprise Architect
provides an easily understood tool for mapping the functional requirements and
behavior of a system.
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Systems Engineer

A Systems Engineer can use Enterprise Architect to produce robust and productive models of complex cyber-mechanical
systems. The models can be requirements, structural and behavioral models, including Use Cases, Package Diagrams,
Block Definition Diagrams, Internal Block Diagrams, Activity Diagrams, Sequence Diagrams, State Machine Diagrams,
and Parametric Diagrams. Enterprise Architect has a comprehensive set of tools to assist the engineer and other
stakeholders.

Systems Engineer Tasks

Task Detail
Define and Manage The field of Requirement Engineering is one of the most critical disciplines in the
Requirements and their solution development lifecycle, and it has a documented impact on the success of
Relationships projects.

Enterprise Architect has an unparalleled range of tools for developing, managing,
visualizing, and documenting requirements, including tools to import, integrate, and
synchronize with external requirement management systems.

Describe User Goals with Systems Engineers use Use Cases as a method for representing functional

Use Cases requirements from the users' perspective. They are goal-driven because the Use
Case defines the goal that the user is trying to achieve while interacting with the
system. Enterprise Architect fully supports the development of Use Case diagrams
and fully supports the modeling and management of Use Case text; it has a unique
and highly productive tool for working with Use Cases, called the Scenario Builder.

Use Blocks to Model The Block is the fundamental unit of system structure. Systems Engineers use

Structure and Constraints blocks to describe an entire system, a subsystem, a component, an item that flows
through a system, a constraint, or entities that reside outside a system. Similar to
our natural languages, a Block can represent something abstract, logical, or
physical.

Enterprise Architect has a rich set of tools that help the systems engineer work with
Blocks and visualize the structure and behavior of these all-important elements in a
system's definition.

Coordinate Behavior with The Activity diagram is formally based on a branch of mathematics called Petri

Activities Nets, and it uses a system of tokens to indicate both the sequence of actions and
also the items that flow through the system. The items that flow can be information
items, physical items, or even control signals.

Enterprise Architect provides a rich toolbox to work with these behavioral elements
and their relationships, including allocating system behavior in the form of
Activities and Actions to Blocks and relating these elements to behavioral features
owned by Blocks, such as operations.

Visualize Systems in Simulation provides a way to see a system in motion and visualize how it behaves
Motion with Simulations through its lifecycle.

As a leading Systems Engineering tool, Enterprise Architect allows a systems
engineer to construct models using industry-compliant modeling techniques and
languages to represent cyber-mechanical systems. These models act as devices for
communication between collaborating engineers, consultants, and others but can
also be used to generate visualizations and simulations using industry-standard
modeling languages used by OpenModelica and MATLAB's Simulink.
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Software Architects

Software Architects can use Enterprise Architect to map functional requirements with Use Cases, perform real time
modeling of objects using Interaction diagrams (Sequence, Timing, Communication or Interaction Overview), design the
Deployment model and detail the deliverable components using Component diagrams.

Software Architect Tasks

Task Detail
Map Functional With Enterprise Architect you can take the high level business processes that have
Requirements of the been modeled by the Business Analyst and create detailed Use Cases.
System

Use Cases describe the proposed functionality of a system and are only used to
detail a single unit of discrete work.

Map Objects in Real Time You can use Interaction diagrams (Sequence and Communication diagrams) to
model the dynamic design of the system.

Sequence diagrams detail the messages that are passed between objects, and the
lifetimes of the objects.

Communication diagrams are similar to Sequence diagrams, but instead display the
way in which the object interacts with other objects.

Map Deployment of You can use Deployment diagrams to provide a static view of the run-time
Objects configuration of processing nodes and the components that run on the nodes.

Deployment diagrams show the connections between hardware, software and any
middleware that is used on a system.

Detail Deliverable Using Component diagrams, you can model the physical aspects of a system.

Components Components can be executables, libraries, data files or another physical resource

that is part of a system.

The component model can be developed from scratch from the Class model or can
be brought in from existing projects and from third-party vendors.

(c) Sparx Systems 2025 Page 18 of 119 Created with Enterprise Architect



Teams & Collaboration 2 September, 2025

Software Engineers

Software Engineers using Enterprise Architect can manually map Use Cases onto Class diagrams, detail the interactions
between Classes, define the system deployment with Deployment diagrams and define software Packages with Package
diagrams.

Software Engineering Tasks

Task Detail
Map Use Cases into Within Enterprise Architect you can study the Use Cases developed by the
Detailed Classes Software Architect, and with that information create Classes that fulfill the

objectives defined in the Use Cases.

A Class is one of the standard UML constructs that is used to detail the pattern from
which objects are produced at run time; to record the relationships between Use
Cases and Classes, you can create diagrams linking the elements with Realization
connectors, and/or map the Realization connectors in the Relationship Matrix.

Detail Interaction Between You can use Interaction diagrams (Sequence and Communication diagrams) to
Classes model the dynamic design of the system.

Sequence diagrams are used to detail the messages passed between objects, and the
lifetimes of the objects.

Communication diagrams are similar to Sequence diagrams, but instead display the
way in which objects interact with other objects.

Define System Deployment Deployment diagrams provide a static view of the run-time configuration of
processing nodes and the components that run on the nodes.

Deployment diagrams can be used to show the connections between hardware,
software and any middleware that is used on a system, to explain the connections
and relationships of the components.

Define Software Packages You can use Package diagrams to detail the software architecture.

Package diagrams are used to organize diagrams and elements into manageable
groups, declaring the dependencies.

Simple Use Case diagram

(c) Sparx Systems 2025 Page 19 of 119 Created with Enterprise Architect



2 September, 2025

P

Teams & Collaboration
= Sequence Diagrams : Sequence Diagram for Login
Communication Diagrams : Communication Diagram for Login

System Boundary

0_—| UNL 2.0 Tuterial Page - Use Cases

|
|
|
One use case can extend the

functicnality of another.

Customer
f

]
'
i

A Use Caese is 8 disorete interaction
betrween a user and the system.

Actors are users of the services
provided by Use Cases

Created with Enterprise Architect

Page 20 of 119

(c) Sparx Systems 2025



Teams & Collaboration 2 September, 2025

Developers

Developers can use Enterprise Architect to perform round trip code engineering, which includes reverse engineering of
existing code and generation of code from Class elements.

Developer Tasks

Task Detail

Round Trip Engineering Enterprise Architect gives you unparalleled flexibility in 'round tripping' software
from existing source code to UML 2.5 models and back again.

Round trip engineering involves both forward and reverse engineering of code,
keeping the model and code synchronized.

Reverse Engineering In Enterprise Architect, you can reverse engineer code from a number of supported
languages and view the existing code as Class diagrams, which illustrate the static
design view of the system.

Class diagrams show Classes and interfaces, and the relationships between them,;
the Classes defined in UML Class diagrams can have direct counterparts in the
implementation of a programming language.

Forward Engineering As well reverse engineering your code into your model, you can forward engineer
elements of your model into code (code generation).

This way you can make changes to your model with Enterprise Architect and
quickly implement the changes in the source code.

Determine the System State To visualize the state of the system you can use StateMachine diagrams to describe
how elements move between States, classifying their behavior according to
transition triggers and constraining guards.

StateMachine diagrams capture system changes over time, typically being
associated with particular Classes; often a Class can have one or more
StateMachine diagrams to fully describe its potential states.

Visualize Package Package diagrams help you design the architecture of the system; they are used to

Arrangement organize diagrams and elements into manageable groups, and to declare their
dependencies.

Follow the Flow of Code Activity diagrams help you develop a better understanding of the flow of code.

Activity diagrams illustrate the dynamic nature of the system; you can model the
flow of control between Activities and represent the changes in state of the system.

Simple Class Diagram
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e You can use StateMachine, Package and Activity diagrams to better understand the interaction between code
elements and the arrangement of the code
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Project Managers

Enterprise Architect provides support for the management of projects. Project Managers can use the system to assign
resources to elements, measure risk and effort, estimate project sizes, and manage element status, change control and
maintenance.

Project Manager Tasks

Task Detail

Provide Project Estimates In Enterprise Architect you have access to a comprehensive project estimation tool
that calculates effort from Use Case and Actor objects, coupled with project
configurations defining the technical and environmental complexity of the work
environment.

Resource Management Managing the allocation of resources in the design and development of system
components is an important and sometimes difficult task; Enterprise Architect
provides you with an effective tool for assigning resources directly to model
elements and tracking progress over time.

Risk Management You can use the Risks window to assign risk to an element within a project; using
risk types you can name the risk, define the type of risk and give it a weighting.

Maintenance Within Enterprise Architect you can assign maintenance-related items to elements
and track them, providing rapid capture and record keeping for items such as
features, changes, documents, issues, defects and tasks.

You can also create and maintain a Project Glossary of processes, procedures, terms
and descriptions.
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Enterprise Architect provides a design testing facility for Testers and Quality Assurance personnel to create a range of
test scripts against elements in the modeling environment.

Testing Tasks

Task

Test Cases

Import requirements,
constraints and scenarios

Create quality test
documentation

Element defect changes

(c) Sparx Systems 2025

Detail

With Enterprise Architect, you can set up a series of tests for each model element.

The test types include Unit, Acceptance, System, Integration, Inspection and
Scenario tests.

To use testing to maintain the integrity of the entire business process, you can
import requirements, constraints and scenarios defined in earlier iterations of the
development life cycle.

Requirements indicate contractual obligations that elements must perform within
the model.

Constraints are conditions that must be met in order to pass the testing process;
constraints can be:

e Pre-conditions (states that must be true before an event is processed)
e Post-conditions (events that must occur after the event is processed) or

e [nvariant constraints (which must remain true through the duration of the
event)

Scenarios are textual descriptions of an object's action over time and can be used to
describe the way a test works.

Enterprise Architect provides the facility to generate high quality test
documentation in .RTF, DOCX and PDF file formats.

In defect tracking you can allocate defect reports to any element within the model,
so that all who are involved in the project can quickly view the status of defects and
see which defects have to be addressed and which have been dealt with.
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Implementation Managers

Enterprise Architect provides support for the management of project implementation. You can track and assign
maintenance -related items to elements within Enterprise Architect, and rapidly capture and update records of
maintenance tasks such as features, changes, documents, issues, defects and tasks. By providing a centralized facility for
each element involved in the deployment process Enterprise Architect offers a convenient solution for tracing the
maintenance of the items and processes involved in system deployment.

Implementation Tasks and Tools

Task Detail
Develop Deployment Using Deployment diagrams, you can model the roll out of a project, including
Diagrams network deployment and workstation deployment.

Users involved in project deployment can add maintenance tasks to the diagram
elements.

Deployment diagrams provide a static view of the run-time configuration of nodes
on the network or of workstations, and the components that run on the nodes or are
used in the workstations.
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Technology Developers

Technology Developers are Enterprise Architect users who create customized additions to the functionality already
present within Enterprise Architect.

Additions include UML Profiles, Patterns, Code Templates, Tagged Value Types, Scripts, Custom Queries,
Transformations, MDG Technologies and Enterprise Architect Add-Ins. By creating these extensions the Technology
Developer can customize the Enterprise Architect modeling process to specific tasks and speed up development.

Developing Technologies

Extension

UML Profiles

Patterns

Code Templates

Tagged Value Types

MDG Technologies

Enterprise Architect
Add-Ins
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Detail

By creating UML Profiles you can create a customized extension for building UML
models that are specific to a particular domain.

Profiles are stored as XML files and can be imported into any model as required.

Patterns are sets of collaborating Objects and Classes that provide a generic
template for repeatable solutions to modeling problems.

As Patterns are discovered in any new project, you can publish the basic Pattern
template.

Patterns can be re-used with the appropriate variable names modified for any future
project.

Code templates are used to customize the output of source code generated by
Enterprise Architect; in this way you can generate code languages not specifically
supported by Enterprise Architect and define how the system generates source code
to comply with your own company style guidelines.

Tagged Values are used in Enterprise Architect to extend the information relating to
an element in addition to the information directly supported by the UML language.

A Tagged Value, strictly, is the value of a property of a modeling item, the property
being called a tag; for example: a Class element called Person might have a tag
called 'Age’ with the Tagged Value of '42'.

More loosely, the combination of tag and value can be referred to as a Tagged
Value.

A Tagged Value Type is a group of parameters that define and/or limit the possible
values of a tag and, in many instances, how a specific value is assigned to the tag;
for example, the tag 'Age’ might have a Tagged Value Type of 'Integer’, so the user
simply types in a numeric value.

Alternatively, the type could be 'Spin', with lower and upper limits of, say, 20 and
120, so the user sets a value by clicking on arrows in the field to increment or
decrement the value within the limits of 20 and 120.

Typically, Tagged Values are used during the code generation process, or by other
tools to pass on information that is used to operate on elements in particular ways.

MDG Technologies can be used to create a logical collection of resources that can
contain UML Profiles, Patterns, Code Templates, Image files and Tagged Value
types that are accessed through a technology file.

Using Add-Ins you can build your own functionality into Enterprise Architect,
creating your own mini programs that can extend the capabilities of the system,
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defining your own menus, and creating your own Custom Views.

(c) Sparx Systems 2025 Page 27 of 119 Created with Enterprise Architect



Teams & Collaboration 2 September, 2025

Database Developers

Enterprise Architect supports a range of features for the development of databases, including modeling database
structures, importing database structures from an existing database and generating DDL for rapidly creating databases
from a model.

Database Development Tasks

Task Detail
Create Logical Data With Enterprise Architect you can build database diagrams using the built-in UML
Models Data Modeling Profile.

This supports the definition of Primary and Foreign Keys, cardinality, validation,
triggers, constraints and indexes.

Generate Schema By using Enterprise Architect's DDL generation function you can create a DDL
script to create the database table structure from the model.

Enterprise Architect currently supports:

e DB2

e  Firebird

e MS Access

e MySQL

e MS SQL Server
e Oracle

e PostgreSQL

Reverse Engineer Database Using an ODBC data connection you can import a database structure from an
existing database to create a model of the database.

By generating the model directly from the database you can quickly document your
work and create a diagrammatic account of a complex database through the
graphical benefits of UML.

Example Data Model Diagram
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Model Discussions

Using the 'Discuss' tab of the dockable Discuss & Review window, you can select an individual element or diagram and
develop an informal discussion that is directly associated with that object. This makes it easy to locate, view and
contribute to a discussion, or more than one discussion, on the selected object.

You can participate in discussions on different elements and diagrams simply by clicking on each object in turn; the
Discuss & Review window immediately switches to the discussion of the new selected object, identified by name
underneath the window tab bar.

As a discussion develops, the number of responses is shown below the original post; therefore you can see when a
discussion has a new reply without having to expand and work through the thread. You can apply a priority and status to
a discussion, which helps you to indicate the importance of the discussion and to resolve and close off the points raised
in the discussion so that they do not continue indefinitely. You can also delete the whole posting or specific replies, to
balance retaining discussion history with removing irrelevant information.

If you are using the Discussions facility a lot and want to ensure that the Discuss & Review window and the 'Discuss' tab
are displayed each time you log back in for a new work session. you can set them as a default display. To do this, click
on the 'Hamburger' icon and select the 'Set this Tab as Default' option.

The discussion comments pertinent to an element can also be displayed in that element on a diagram, in the 'Discussion’
compartment of the element.

Access

Select an element or diagram, then open the Discuss & Review window using one of these methods:
Ribbon Start > Collaborate > Discuss > Discuss

Context Menu Browser window > Right-click on object > Collaborate > Discuss

On diagram > Right-click on element > Collaborate > Discuss

Keyboard Shortcuts Ctrl+9 > Discuss

Operations in Discussions

Operation Action

Create a Discussion At the top of the tab, the message Create New Discussion displays. You have two
options, direct entry or indirect entry.

In direct entry (better for short messages), either double-click on the message or
right-click on the window and select the 'Create new Discussion' menu option. Type
or paste your posting. The text automatically wraps at the border of the Discuss &
Review window. As you type, you can right-click on the text and perform the usual
Notes text operations such as formatting and setting translation flags.

There is an option on the Preferences window, 'Window Behavior' page that sets
whether to use either the Enter key or the Ctrl+Enter keys to submit a topic or post.
Whichever you select, you can use the alternative option to break and insert a new
line in your Discussion text.

When you have finished typing, click off the text or press the Enter key (or
Ctrl+Enter keys).
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In indirect entry, press Ctrl+Spacebar to display a simple text window and type or
paste your discussion text there. When you have finished your message, press the
Esc key to transfer the text to the 'Discuss' tab. Then press the Enter key. The
advantage of the indirect method is that you can edit and format the text - especially
in long messages containing several paragraphs - without risk of accidentally
submitting it incomplete as a Discussion item.

When you press the Enter key:

e An open expansion arrow and a % icon display to the left of your text

e  Your user ID and the time of posting display just underneath your text,
followed by the text 0 recent

e The message Create New Discussion displays above your text
All new discussions are added to the top of the 'Discuss' tab.

If user security is enabled and you have selected to show avatars, the discussion
icon is replaced by an image representing the user who contributed that item. If a
user does not have an avatar image, a default 'head and shoulders' silhouette
displays as the avatar.

Note that your text might contain words that are automatically underlined. These
are terms for which a Glossary definition has been created, and positioning the
cursor over one of these words will display the definition in a pop-up message box.
If you do not want to indicate glossary terms, right-click on the message and click
on the 'Highlight Glossary Terms' menu option. This will clear the automatic
underlines across the system. Do this again if you want to restore the underlines.

Once a discussion has been started on an element or diagram, you can set a flag to
notify you whenever a response is posted to the thread. To set the flag, right-click
on the diagram name in the Browser or the element name in the Browser window or
in a diagram, and select the 'Collaborate > Monitor Discussions' option. The flag
then operates for your user ID.

When a response is posted in a monitored discussion, the notification is a Msg

button | ® M58 | hat displays at the right hand end of the application title bar.

1. Click on the drop-down arrow; a list of the monitored elements that have
unopened responses is displayed.

2. Click on the element to investigate; the Discuss & Review window displays,
showing the 'Discuss' tab and the response to the discussion thread.

If you want to remove a discussion flag - or all discussion flags you have set - on

the 'Discuss' tab of the Discuss & Review window click on the = icon and select
the 'Manage Monitored Discussions' option. The 'Manage Monitored Discussions'
dialog displays, showing the monitored element names and their type, author and
last-modified date.

e  Click on a specific element, or Ctrl-click on multiple names, and click on the
Delete button to stop monitoring the discussions on those elements, or

e  Click on the Select All button and on the Delete button to clear all elements
from your monitored discussion list

e Ifyou have selected elements but do not want to remove all of them, click on
the Clear All button and make a different selection

If you are spending time working in diagrams, there is also a convenient facility to
monitor and access Discussions on elements within the diagram. See the
Collaboration Support in Diagrams Help topic.

You enter a reply to a discussion topic by clicking on the expansion arrow next to
the discussion item. This changes the display to show just the selected Discussion
topic at the top of the window and any existing responses to that topic underneath
it, after a line broken by the text Open, n Posts.
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You then press the Enter key to place the cursor at the start of the text entry field at
the top of the tab. Either:

e  Type your response, or

e Press Ctrl+Spacebar and type the text in the 'Post Reply' text box; when you
have finished, press the Esc key to place the text in the 'Discuss' tab

Click on the Post button.
e The response displays at the top of the list of replies

e  Your user name displays above the response, with your avatar to the left of it
(and subsequently the date of posting displays on the right)

e The time of posting displays on the left of the response
e As more responses accumulate, the Post count increments

All new replies are added underneath the Discussion thread they are in response to.
All responses you make before someone else posts are grouped together underneath
your user name.

To return to the Discussion list mode, click on the large arrow to the left of the
reply text box.

Filter Discussions The default order of display of Discussions is to show all open Discussion topics in
a list, with the most recent topic at the top. There are a number of context menu
options available for you to filter which Discussions are listed, and which
Discussions are presented first.

e Show Closed Topics - Include in the list topics of discussions that have been
closed

e Visible Timeframe - Confine the list to Discussions created today, in the last 3,
7, 30 or 90 days, or restore the list to all Discussions; the "Today+' option
shows Discussions from today and the 20 most recent postings prior to today

e Always Visible - Always display Discussions that have one or more of the
statuses Open, Error, Alert, Accept, or Reject; you also have options to select
discussions of all statuses, or to clear all status selections in the list

e  Sort by Most recent Activity - Display the list of discussions with the most
recent exchange of responses at the top, and the least active Discussions at the
end

Edit Postings Whilst you are typing a message, the editor automatically checks the spelling and
underlines possible spelling errors in red. You can backspace or move the cursor to
the errors to correct them. You can also move the cursor anywhere in the message
body and add or delete text (press the Delete key).

Once you have pressed the Enter key to post a message, you can delete the whole
message but you cannot edit it.

Copy Discussion Text If you want to re-use some or all of the text of a saved Discussion item, you can
open the text in a (read only) pop-up dialog, by pressing Ctrl+Space. You can then
select the text you want and press Ctrl+C to copy it to the clipboard. Alternatively,
you can right-click a Discussion item and choose "Copy to Clipboard", to copy all
of the text from that item.

The copied text can then be pasted into a new Discussion item or into another
document in Enterprise Architect.

Push to My Workbench Users have the ability to 'push' the text of a selected discussion post, directly from
the discussion into their workspace in My Workbench. This feature streamlines the
workflow by allowing transfer of relevant information without the need for manual
copying or re-entry.

To 'push’ text to your workbench, right-click on the desired entry in the discussion,
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then select the option 'Push to My Workbench'.

Set Discussion Status . . . S . .
The & icon against a new Discussion indicates that the Discussion has the status of

'Open'. To change the status, right-click on the Discussion item and select either:

e Alert

e Error

e Accept
e Reject
e Closed

If the Discussion already has one of these statuses, you can also select the 'Open’
option to return the Discussion to 'Open' status.

When you review the Discussions in the Discuss & Review window, you might
want to include Discussions that have the status of 'Closed’, or you might prefer to
hide them. To toggle the inclusion of closed Discussions, right-click on the body of
the window and click on the 'Show Closed Topics' option.

Set Discussion Priority As part of the Discussion, you might want to identify the priority of a point being
raised. It might be very important to act on the point, or it might be agreed that the
point discusses a 'nice to have' feature that could be addressed at a later date. To set
the priority, right-click on the Discussion topic and select one of the options:

e  'Priority | High' (")

e 'Priority | Medium' (" ), or

e 'Priority | Low' (")

Alternatively, if you decide that an item does not need to be prioritized, select the
'Priority | <none>' option. This leaves the item icon as

Search for Discussion Right-click on the body of the 'Discuss' tab (in discussion list mode for an element)
items on an element or and click on the 'Search Discussions' option. The Create New Discussion text
diagram changes to Enter text to search discussions.

Double-click on that message and then type in the text you want to locate in any
discussion topics for the selected element. Press the Enter key.

The system runs a search for any topic that either contains that text or has a post
(reply) that contains the text. The search results are listed in the tab, under the text
Displaying search results for term <search term>. You can double-click on this
row to type a new search term and re-run the search.

Clicking on a discussion item in the search list switches to the 'post reply' mode,
where you can read the original topic and all responses to it. Clicking on the large
arrow button returns you to the list of search results.

To return to the normal list of discussion items for an element, press the Esc key,
reload the tab, change context, or right-click and click on the 'Search Discussions'
option again.

Delete a Discussion or Right-click on the Discussion or a reply, and select the 'Delete Selected' menu
Reply option. A prompt displays to confirm the deletion. Click on the Yes button.

If you delete a Discussion, all replies associated with that Discussion will be
deleted as well.

Review Discussion History Either:
e  Click on the object name bar at the top of the window, or

e Right-click within the body of the window, or
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e  Select the 'Start > Collaborate > Discuss' ribbon option
In each case, select the 'Discussion History' option.

The Discuss & Review History window displays at the 'Discussions' tab, listing all
existing discussion items on elements and diagrams.

Notes

e  The Discussions facility is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect

e If you are working with an External Data Provider in a Cloud-connected model, you can review external data item
features and characteristics in the 'External’ tab of the Inspector window; see the External Item Details Help topic

e Ifthe editor does not highlight spelling errors, select the 'Start > Appearance > Preferences > Preferences > Objects'
ribbon option and deselect the 'Disable Spelling' checkbox

e A standard report is available for locating elements that have recently been the subject of Discussions; select the
'Start > Collaborate > Discuss > Recently Discussed' ribbon option
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Model Reviews

A Review element is a simple yet effective mechanism for capturing, in real time, discussions concerned with a
particular event on one or more elements and/or diagrams. Typically, a Project Manager or other coordinator will create
a Review element specifically to discuss one or more objects for a project phase, project stage or other category of
review, over a defined period. A number of reviewers then 'join' the review and enter discussion points and responses in
the Discuss & Review window. Note that you can only be joined to one Review element at a time.

Review elements can be used in a number of contexts, including model development, testing, delivery, maintenance and
management. They can be added to specific Review diagrams - which have their own 'Review' Toolbox page - or to more
general diagrams, using 'Review' icons from the 'Review', 'Artifact', 'Maintenance' or 'Management' Toolbox pages.

Review elements are generally set up and managed within Enterprise Architect, but users both of Enterprise Architect
and of the WebEA facility can use Review elements to direct their input to discussions on project and model reviews.

If you want to simply comment on or discuss an element or diagram without capturing your discussion in a formal
review, use the 'Discuss' tab of the Discuss & Review window. See the Model Discussions Help topic.

Setting Up a Review

The most direct and structured scenario would be for the review coordinator to create the Review element through the
Reviews view.

The Review element is a composite element to which the review coordinator would add a review diagram (as a 'Review
Set') and then add to that diagram the elements and/or diagrams (as Navigation Cells) to be reviewed. Each Navigation
Cell effectively forms a Review Set of elements itself.

A joined reviewer simply selects objects on the diagram and creates discussion topics or responses on each object using
the 'Review' tab of the Discuss & Review window. The process for an element under review can be monitored and
eventually approved by one or more designated 'Approvers' assigned to the individual element through the 'Review' tab.

The Project Manager might also set a status that, when an element under review reaches it, locks the element against
review until it assumes a different status, as described in the Take Part in a Review Help topic.

The Review element also acts as a bridge to continue focused discussions in subsequent work sessions. If you want to
ensure that the Discuss & Review window and the 'Review' tab are displayed each time you log back in for a new work
session. you can set them as a default display by clicking on the 'Hamburger' icon and selecting the 'Set this Tab as
Default' option.

Using Review Elements

Review elements are used to plan and coordinate a formal review of part of your model, defining:
e When the review is to start and end

e What elements or diagrams are to be reviewed (and, as the review progresses, which objects have not yet been
reviewed)

e The current status of the review

e Any specific instructions for performing the review
e Who is involved in the review

e Any resources to use during the review

e  The priority of the review

The start and end date information is defined in two special EAReview Tagged Values (on the Review element
'"Properties' dialog, see the 'General' page and 'EAReview' tab):

e EndDate - the date on which the Review will be complete with no further discussions expected

e  StartDate - the date from which users can join the review, and add discussions and responses
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Other information can be provided through the Review element's normal element properties including Linked
Documents, Notes and associated Note elements, Tagged Values and attributes. Review elements and their contents can
be the subject of searches and document generation, all of which add to the information-gathering and grouping purposes
of the element. The element also has a child diagram that aids planning, management and coordination of the review, and
that provides a quick overview of and access to the elements under review.

The review comments pertinent to an element can be displayed in that element on a diagram, in the Review
Compartment of the element.
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Create a Review Element

You have two starting points for setting up a review, either:
e  Create and/or open a diagram and drag onto it the Review element icon from the Diagram Toolbox, or

e Create a Review element from the Manage Reviews view and subsequently add it to an open diagram via the
Browser window

In either case, your objective is to have a diagram containing a Review element, with a number of model elements and/or
Navigation Cells for diagrams, which are the objects to be reviewed. This forms a simple, tidy, visual tool for managing
the Review.

At the end of each of the two 'create element' processes, you are joined to the Review you have created and can make
preliminary comments for the review.

Create a Diagram First

1. In the Browser window, on the parent Package for your Reviews, right-click and select the 'New Diagram' option to
display the 'Diagram Builder' tab page of the 'Model Builder' dialog.

2. Click on the = icon and select the perspective 'Construction > Reviews & Discussions' then, in both the 'Select
From' and 'Diagram Type' panels, click on the 'EAReview' option. Click on 'Create Diagram' to create the new
diagram.

Alternatively, open an existing Review diagram, or create and/or open a diagram of any other appropriate type, as
you prefer.

3. Drag onto the diagram the 'Review' icon from the Diagram Toolbox; the icon and element have these appearances:
i '
- .G. -
House Review

Today to 30/Jan
Author: David Steele

Review L y

The element defaults to the Info View style, which you can edit or disable.

4. Display the element 'Properties' dialog and, on the 'General' page, enter the information as explained in the
remaining steps.

5. If necessary, overtype the element name with a different name.

6. In the 'Status' field click on the drop-down arrow and select the appropriate status - normally 'Proposed’, but you can
also select from 'Active', 'Deferred' or 'Closed'.

7. Click on the EAReview tab and, in the 'EndDate' field, click on the drop-down arrow and select the date on which
the review should complete.

8. In the 'StartDate' field, click on the drop-down arrow and select the date on which the review should begin. Click on
the OK button.

9. The populated element displays in the diagram. Right-click on the diagram and select the 'Save current changes'
option.

10. Right-click again and select the 'Join Review' option; the Review is opened to you as a joined reviewer, on the
'Review' tab of the Discuss & Review window, and you can create some initial discussion points.

11. From the Browser window, drag the elements and diagrams to be reviewed onto the diagram. See the Add Objects
for Review section.
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Create an Element First

1. Open the Reviews View (the 'Start > Collaborate > Review > Manage Reviews' ribbon option).

2. Right-click on the View background and select the 'New Review' option; the 'Create Review' dialog displays, with
the 'Name' field defaulting to the name of the currently-selected Package.

If necessary, overtype the 'Name' field with a different name.

4. In the 'Status' field click on the drop-down arrow and select the appropriate status - normally 'Proposed’, but you can
also select from 'Active', 'Deferred' or 'Closed'.

5. Inthe 'Start' field, click on the drop-down arrow and select the date on which the review starts.

6. Inthe 'End' field, click on the drop-down arrow and select the date on which the review should complete. Click on
the OK button.

7. Inresponse to the prompt for the owner Package, either accept the current Package or browse for a different
Package. Click on the OK button.

8. You are automatically joined to the review, on the 'Review' tab of the Discuss & Review window, and can create
some initial discussion points.

9. Now create and/or open a diagram to contain the Review element and the objects to be reviewed. See the Add
Objects for Review section.

Add Objects for Review

A formal review can be of a single element or diagram, or several objects together. To identify and organize the objects
to be reviewed, you drag the objects from the Browser window onto the Review diagram. If you have created the Review
element directly in the Reviews view, you also drag the Review element itself onto the Review diagram.

As you drag each element onto the Review diagram, drop it as a Link.
As you drag a diagram onto the Review diagram, drop it as a Diagram Reference or Navigation Cell.

You might also want to create a Note element on the diagram, containing information and instructions on the review for
the Reviewers.
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Assign Approvers to a Review

An Approver is someone assigned to one or more specific objects in a review to monitor the review of those objects and
ensure it is conducted satisfactorily. If you intend to assign an Approver to an object under review, you can do this
through the 'Review' tab of the Discuss & Review window, after adding the objects to be reviewed to the Review
diagram.

Assign an Approver

In a review that you have joined, work through these steps:
1. Press Ctrl+9 to display the Discuss & Review window, and select the 'Review' tab.

2. In the Review diagram, or in the Browser window, or in the right-hand panel of the Reviews view, click on the
element to be reviewed.

3. The element name displays on the 'Review' tab; right-click on the name and select the 'Create Approver' menu
option. The 'Create Approver' dialog displays.

4.  Click on the Add button and - in the list - double-click on the name of the required Approver. If you want to add
more than one Approver, click on the Add button again and select the next Approver.

5. Click on the Create button. The name of each Approver is added as a separate item to the element in both the
Reviews view and the 'Review' tab; if this is not visible, click on the expansion arrow for the element. The
Approvers are listed in alphabetical order.

When an Element Has Approvers

In the 'Review' tab the message 0 out of <n> Approvals displays under the element name, followed by a user name item
for each of the assigned Approvers. In the message, 0 is the count of approvals registered, and <n> is the number of
Approvers required to approve the review of the element. If no Approvers have been assigned, no message displays.

As the review progresses, the Approver(s) will monitor the process until the appropriate point to change the status (from
'Open' to 'Alert' or 'Accept’, usually) is reached. The Approver changes the status by right-clicking on their name in the
'Review' tab and selecting the appropriate value.

If there are two or more Approvers, when one changes the status a standard message is automatically sent by Model Mail
to the other Approvers, in this form:

<approver name> has updated the Approval Status for <element name> in the review Review - <name>.
The status has changed from <original status> to <new status>.

Please check the Review item and action as required.

A link to the element under review enables the Approver to access the element directly.

Alternatively, rather than send a message to indicate they have faken action, an Approver might want to remind another
Approver to take action. In this case, in the Reviews view, the first Approver would right-click on the required Approver
name and select the 'Send Approval Reminder' option. A standard message is displayed and, if required, the sender can
add further text and/or additional addressees. The standard message has this format:

A reminder that you are an Approver on the item <element name> and action may now be required as part of that
Review.

Please check the Review item and action as required.

Again, the recipient has a link to the element under review, to access it directly.
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Locate Review Elements

In order to join a review, you have to list the available Review elements and locate the appropriate one. There are a few
options for doing this.

From the Reviews View

Either:

e  Select the 'Start > Collaborate > Review > Manage Reviews' ribbon option, or

e In the Discuss & Review window, on the 'Review' tab, click on the = icon and select the 'Manage Reviews' option

The Reviews view displays, showing the Review elements that exist in the model grouped according to their 'Status'
value, in alphabetical order.

@ start Page 5] Specification Manager | i Reviews x

Review a | % Element

Discussion Status | Discussio..  Closed | Open Replies Priarity
P r 2 P P o
dActive )
A [ Review - Take Crders Ative 1 7
B Gz = T@ O A [E] Review - Take Orders 4 1 3 17
AClosed fx REQUIZ - Provide Online Sales 1 1 4
[ Artifact [ REQOA - Shopping Basket z 1 1 il
[ REQOS - Process Credit Card Payment 1 1 5
ABetened b B General ] 4 3
[ Artifact

AProposed
[ 15.2 Web Page
[ Artifact

Click on the Review you require and, in the right-hand panel, expand and explore the review for the elements in that
review. The currently-selected item is displayed in the 'Review' tab of the Discuss & Review window.

Further information on the Reviews view is provided in the Manage Reviews Help topic.

Using the = icon you can also get information on a selected review by selecting:

e 'Current Review Details' to display the discussion history of your current Active review, and to show the details of
the elements reviewed

e 'Find Current Review in Browser' to locate your Active Review element in the Browser window

From the Discuss & Review Window, Review Tab

The 'Review' tab is usually the point at which you begin working on a Review that you have located and joined.

However, you can also use an option on this tab to locate all reviews with the status of Active, and join a selected review
immediately.

Either:

e Click onthe = icon in the tab heading and select the 'Join Review' menu option or
e Right-click on the body of the display and select the 'Find Review to Join' menu option

In either case the 'Select Active Review' dialog displays, listing the Active reviews in the project.
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Select Active Review A

P s Stark Date End Date
EF{eview-Take Qrders 20,055 2020 29/05/2020 |

| Dizconnect when | log out Cancel

Before you actually join a review, consider how much work you intend to do on the review, when you intend to do it, and
how inconvenient it might be to locate and join the review again in a subsequent work session. If you would prefer to:

e Automatically be joined to the review when you log in again to another work session, clear the 'Disconnect when |
log out' checkbox

e Leave the review when you log out and manually rejoin it at some later time, leave the 'Disconnect when I log out'
checkbox selected

Now click on the review you want to join, and click on the Join button. The dialog closes and you are joined to the
review.

From Reports

Enterprise Architect provides six reports on Review and Discussion items, which you can access from the Start Page
'Search in Project' tab.

Select the 'Discussions' option in the drop-down list in the third field, and then click on the drop-down arrow in the
second field and select one of these reports:

e Recently Discussed Elements - lists the elements that have recently been discussed in reviews

e Recent Element Posts - lists the recent discussion comments that have been posted against elements under review
e Review - lists the Review elements that exist in the model

e Recently Modified Reviews - generates a list of Review elements that have been recently created or modified

e Recently Discussed Reviews - generates a list of Review elements in which discussions have taken place

e Open Reviews - generates a list of Review elements with the status 'Open', which can be joined for discussion
When you have located your required Review, either:

e  C(Click on it to display the Review in the 'Review' tab of the Discuss & Review window, or

e Double-click on it to display the Review details in the Review view
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Join a Review

When a review is first set up, the person managing the review will send an email inviting the reviewers to join it. This
email is likely to contain links to the Review diagram and the Review element in the Browser window. You can use
those links to highlight the object:

e In the Browser window (mouse over the link and click on the icon)

e In the Review diagram (mouse over the link and click on the icon), or
e In the Review view (double-click on the link)

Having located the object, you can join the review on it in a number of ways, both at this initial point and at any
subsequent time when you want to work on the review, as outlined in the sections of this topic. When you join the
review, the Discuss & Review window displays at the 'Review’ tab; the name of the Review element then becomes the
button name at the top of the screen, and the name of the selected element being reviewed displays beneath that.

Discuss & Review v I X

Journal Discuss Review

= In Review : Review - Take Orders -

> REQ116 -The system must email the client
a copy of the receipt { Review - Take
Orders

0of 1 Approvals

4 A Isthis required o be entirely automated, &£
or is there manual intervention at any
point?

Hugh Loyd 18/05/2020 : 1 Reply © Last
rapy By Ray Shition 18/092020

<L Roy Chillion 18/05/2020

It iz actually mare secure 1o have an
automated response based on
processing the payment on the
order, so the Requirement should
state that. However, &Action on
Derrick to contact Jordan Ellis 1o
clarify whether there might be a
secondary requirement for manual
back-up.

From the Browser Window

Right-click on the Review element in the Browser window and select the 'Join Review' context menu option.
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From the Review Diagram

Right-click on the Review element in the diagram and select the 'Join Review' context menu option.

From the Reviews View

Click on the Review element in the Review view and select the 'Join Review' context menu option. This makes the
Review your Active Review, and the element name displays in bold.

In subsequent work sessions, to display the Review view, select the 'Start > Collaborate > Review > Manage Reviews'
ribbon option.

From the Discuss & Review Window, Review Tab

The Discuss & Review window 'Review' tab is where a joined Review begins, but if you have the tab displayed with no
Review element listed at the top, you can locate all Reviews with the status of 'Active', and join one of them.

Either:

e Click on the = icon in the tab heading and select the 'Join Review' menu option or
e Right-click on the body of the display and select the 'Find Review to Join' menu option

In either case the 'Select Active Review' dialog displays, listing the Active reviews in the project.

Select Active Review A

Fewienies Start Date End Date
EREUiEW-TakE Qrders 25,/05, 2020 20/05,/2020 |

- Dizconnect when | log aut Cancel

Before you actually join a review, consider how much work you intend to do on the review, when you intend to do it, and
how inconvenient it might be to locate and join the review again in a subsequent work session. If you would prefer to:

e Automatically join to the review when logging in for a new work session, clear the 'Disconnect when I log out'
checkbox

e Leave the review when you log out and manually rejoin it at some later time, leave the 'Disconnect when I log out'
checkbox selected

Now click on the review you want to join, and click on the Join button. The dialog closes and you are joined to the
review.

Note that you can also right-click on the dialog and select the 'Join Review' menu option. There is also an option in the
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menu to locate the Review element in the Browser window.

Result of Joining

When you have joined a review, that is your Active review and the Review element links to the review topics and posts
you create. You can create discussion topics, reply to other users' discussion topics, and adjust the status and priority of
each discussion. See the Take Part in a Review Help topic.

When you have completed your review work, select the 'Leave Review' context menu option or log out. However, note
that the result of logging out depends on the setting of the 'Disconnect when I log out' option in the ' Select Active
Review' dialog, as explained in the From the Discuss & Review Window, Review Tab section.
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Take Part in a Review

After you have joined a review, you create and respond to discussion topics on the 'Review' tab of the Discuss & Review
window (if it is not currently displayed, select the 'Start > Collaborate > Review > Review' ribbon option, or press Ctrl+9
and select the 'Review' tab). Initially, this only displays the name of the Review element.

You then select the element to review, or the Navigation Cell for the diagram to review, in the:

Review diagram
Reviews view
Browser window (and right-click on the object | Collaborate | Review)

Non-Review diagram (and right-click on the object | Collaborate | Review)

This makes the selected model object the focus of the Discuss & Review window 'Review' tab. Any existing review
topics for the object display in the body of the window in reverse date/time order, with the most recent topic at the top of
the list.

Discuss & Review v 0 X

Journal Discuss Review

=— In Review : Online Boaokstore - Manage Users -

‘ Pozt

<L Review Details fro REQO12 [
Ray Chillian 12 Sap 1 ragly /0 todasy
{ Press Snter o S Mew Post )

<L Roy chillion 12sep
1217 Changed Priority to Wedium'

Contributing to a Review

To create a topic for review or make a response to a topic, use the guidelines provided in this table.

Operation Action

Create a Review Topic Below the element name, but above any existing review conversation, the message
Create Review Topic displays. Note that an element under review can be locked
against posting any further topics or responses, according to the element's status. In
this case the message This Review is now <status triggering the lock> and cannot
be updated displays instead.

Double-click on the Create Review Topic message and type your topic as
continuous text. The text automatically wraps at the border of the Discuss &
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Review window.

There is an option on the Preferences window, 'Window Behavior' page that sets
whether to use either the Enter key or the Ctrl+Enter keys to submit a topic or post.
Whichever you select, you can use the alternative option to break and insert a new
line in your topic text.

When you have finished typing, click off the text or press the Enter key (or
Ctrl+Enter keys).

e An open expansion arrow and a % jcon display at the start of your text, and
your user name, the time or date of posting and the number of replies (initially
zero) display beneath your text

e The message Create Review Topic displays above your current discussion
topic, and the message Post reply displays underneath the topic

If user security is enabled and you have selected to show avatars, the discussion
icon is replaced by an image representing the user who contributed that item. If the
user does not have a personal avatar image, a default 'head and shoulders' silhouette
displays as the avatar.

Note that your text might contain words that are automatically underlined. These
are terms for which a Glossary definition has been created, and positioning the
cursor over one of these words will display the definition in a pop-up message box.
If you do not want to indicate glossary terms, right-click on the message and click
on the 'Highlight Glossary Terms' menu option. This will clear the automatic
underlines across the system. Do this again if you want to restore the underlines.

Add a Response You enter a reply to a Review topic by clicking on the expansion arrow next to the
Review item. This changes the display to show just the selected Review topic at the
top of the window and any existing responses to that topic underneath it, after a line
broken by the text Open, n Posts.

You then press the Enter key to place the cursor at the start of the text entry field at
the top of the tab. Either:

e Type your response in the test entry field, or

e  Press Ctrl+Spacebar and type the text in the 'Post Reply' text box, then press
the Esc key to close the text box

Click on the Post button on the right of the text entry field.
e The response displays at the top of the list of replies

e  Your user name displays above the response, with your avatar to the left of it
(and subsequently the date of posting displays on the right)

e The time of posting displays on the left of the response
e As more responses accumulate, the Post count increments

All new replies are added underneath the Review thread they are in response to. All
responses you make before someone else posts are grouped together underneath
your user name.

To return to the Review list mode, click on the large arrow to the left of the reply
text box.

Edit Postings Whilst you are typing a message, the editor automatically checks the spelling and
underlines possible spelling errors in red. You can backspace or move the cursor to
the errors to correct them. You can also move the cursor anywhere in the message
body and add or delete text (press the Delete key).

Once you have posted a message, you can delete the whole message but you cannot
edit it.

Search Reviews Right-click on the body of the 'Review' tab (in list mode for an element) and click
on the 'Search Reviews' option. The Create Review Topic text changes to Enter text
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Copy Review Topic Text

Set Review Topic Status

Set Review Topic Priority

Set Approval Status

Delete a Review Topic or
Reply
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to search reviews.

Double-click on that message and then type in the text you want to locate in any
Review topics for the selected element. Press the Enter key.

The system runs a search for any topic that either contains that text or has a post
(reply) that contains the text. The search results are listed in the tab, under the text
Displaying search results for term <search term>. You can double-click on this
row to type a new search term and re-run the search.

Clicking on a review item in the search list switches to the 'post reply’ mode, where
you can read the original topic and all responses to it. Clicking on the large arrow
button returns you to the list of search results.

To return to the normal list of review items for an element, either press the Esc key,
reload the tab, change context, or right-click and click on the 'Search Reviews'
option again.

If you want to re-use some or all of the text of a saved Review posting, you can
open the text in a (read only) pop-up dialog, by pressing Ctrl+Space. You can then
select the text you want and press Ctrl+C to copy it to the clipboard.

The copied text can then be pasted into a new Review posting or into another
document in Enterprise Architect.

A new review topic has the status of 'Open'. To change the status, right-click on the
item and select 'Status' and:

e Alert
e  Error
e Accept

e Reject, or
e C(Closed

If the review topic already has one of these statuses, you can also select the 'Status |

Open' option to return the topic to 'Open' status, indicated by the £ icon.

As part of the review, you might want to identify the priority of a point being
raised. It might be very important to act on the point, or it might be agreed that the
point discusses a 'nice to have' feature that could be addressed at a later date. To set
the priority, right-click on the review topic and select one of the options:

e 'Priority | High' (")
e  'Priority | Medium' (" ), or
e  'Priority | Low' (")

Alternatively, if you decide that an item does not need to be prioritized, select the
'Priority | <none>' option. This leaves the item icon as

Only the named Approver is able to change the status or priority of their Approver
item. To set the status, the Approver right-clicks on their Approver item and can
select the same options as for a reviewer. However, the final option in this case is
'Approved', which indicates that the selected element has completed review and all
decisions and defined changes are approved.

If the Approver selects the 'Approved' option, the indicator then displays to the
right of the item and the 0 out of <n> Approvals message is incremented to show
that the element has received one of the required Approvals.

Right-click on the review topic or a reply, and select the 'Delete Selected' menu
option. A prompt displays to confirm the deletion. Click on the Yes button.
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If you delete a review topic, all replies associated with that topic will be deleted as
well.
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Manage Reviews

You manage reviews using the Reviews view, which lists all the Review elements in your model in the left-hand
'Review' panel with - for a selected Review element - the details of the elements and diagrams under review in the
right-hand panel. This allows you to quickly see what reviews are taking place and what is happening within any review
you want to explore.

Reviews o x
Review Item ¥ | Topic Status ¥ | Approval Status ™ | Priority ¥ | Recent Replies ™
r B Online Bookstore - Manage Users r E Online Bookstore - Manage Users
Active, 19/01/2022 to 28/02/2022 4 ] Online Bookstore - Manage Users
4 Approvals REQO11 - Manage User Accounts
Open: 1 [ REQO16 - Add Users
4 Discussions REQO17 - Remaove User
Open: 3 REQO18 - Report on User Account
4 Priority REQ024 - Secure Access
Medium: 1 REQO25 - Store User Details
4 Recent ] REQO26 - Validate User
No Items Found ) Do we have suitable methods for validating the user's Open
> [ Reguirements Review - Sprint 3 ) Where user's save their credit card details as a paymen... Open
Proposed. 21/02/2018 to 23/02/2018 4 E General
I [ Review - Package1 [> [ Online Bookstore - Manage Users
BiuncseciiU/ G 201240 07 0 2018 4 A REQO12 - Process Credit Card Payment
I> [2] Review1 % Review Details fro REQD12 Open Medium
Proposed. 10/06/2021 to 25/06/2021
Access
Ribbon Start > Collaborate > Review > Manage Reviews
Context Menu On a Review element on a diagram or in the Browser window, right-click and select

the 'Properties | Special Action' menu option.

Keyboard Shortcuts e In the Browser window, click on an existing Review element and press Shift +
Enter

e  On adiagram, click on a Review element and press Enter, or double-click on
the element

Other In the Discuss & Review window, click on the 'Review' tab and on the 'In Review'
button, and select the 'Manage Reviews' option.

Joining and Leaving Reviews

If you are already joined to a review, that Review element is displayed in the list in bold.

Otherwise, you can join a review by right-clicking on the Review element name and selecting the 'Join Review' option.
Equally, you can leave your active review by right-clicking on it and selecting the "Leave Review' option.

If you cannot locate a review that covers the objects you want to assess, you can also create a new review based on an
existing selected Package. Select the Package in the Browser window and then right-click on the Review view and select
the 'New Review' option. The 'Create Review' dialog displays; see the Create a Review Element Help topic.
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Viewing Information

The columns of the display show a number of properties of the Review element, the Review diagrams, and each object in
the review. Depending on which column headings you choose to display using the 'Field Chooser' menu option, these
properties can include the start and end dates of the review period, the number of topics posted for the diagram and for
each object, the number of those topics of each status, and the number of topics and replies posted within various periods
of time. As well as choosing which columns to display, you can change the sequence of the columns by dragging the
column headings across the heading band.

You can right-click on:

e An object name to display the object's Review topics and comments on the 'Review' tab of the Discuss & Review
window

e A Review element or Topic-level element to expand the branch or expand the whole display, or collapse the exposed
contents

e An object name to find the object in the Browser window (or double-click on the item); this also opens the Discuss
& Review window for the object

e An element name to locate any diagrams that contain the element

e An element name to display the Test Cases window, Maintenance window and/or Resource Allocation window,
showing tests, maintenance items and resources associated with that element

e A diagram name to select the 'Open' option to display the diagram

e The window and select the 'Refresh' option to refresh the list, to include any review topics that have been posted
since you opened the review

You can sort the information displayed in the right-hand panel, by right-clicking on the panel, then selecting 'Sort by..."
from the context menu. You can sort either by 'Name', or by 'Phase then Name'.

You can also filter the display from the 'Review' panel, by double-clicking on a property. The right-hand panel then
displays the information specific to that property. For example, if you were to double click on the 'Open' property in this
Review panel, the information shown relates to just that property.

Reviews o x
Review Item ¥  Topic Etdtus@pp\'oval Status ¥ Priority ¥ RecentReplies ~
4 B Online Bookstore - Manage Users A B Online Bookstore - Manage Users
Active. 19/01/2022 to 28/02/2022 4 E] Online Bookstore - Manage Users
4 Approvals A REQO26 - Validate User
Open: 1 ) Do we have suitable methods for validating the user's Open
4 Discussions 9 Where user's save their credit card details as a paymen... Open
Open: 3 4 E General
4 Priority A REQO12 - Process Credit Card Payment

Medium: 1 ) Review Details fro REQD12 Medium

4 Recent
No Items Found
I [ Requirements Review - Sprint 3
Proposed. 21/02/2018 to 23/02/2018
I> [2] Review - Packagel

Proposed. 07/03/2019 to 07/03/2019

b [ Reviewl
Proposed. 10/06/2021 to 25/06/2021

Review Sets

Click on the Review item you have joined, and check the objects under that review in the right-hand panel.

For each Review element there is at least one segment or 'set' of objects; the first set identifies the objects added to the
Review diagram, to be reviewed. There can be other sets of objects that are identified on other Review diagrams
identified to the review.
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You can add such sets of objects on their diagram by right-clicking on the Review element name and selecting the 'Add
Review Set' option. The 'Add Review Set' dialog displays, on which you specify the name of the new diagram. Click on
the OK button. The diagram is created as a child of the Review element in the Browser window, and its name is added
under the Review element name in the Review view. You can then populate the diagram with elements and/or diagram
Navigation Cells to form a set to be reviewed as part of this review. Each Navigation Cell effectively defines a Review
Set of elements itself.

The final segment (labeled 'General') identifies any review activity on the Review element itself, or on any other
elements in the model that are added to the review but not included on a Review diagram.

Locking Elements Under Review

Towards the final stages of a review of an element, the review managers might want to collate information before
inviting final comments, approval or sign-off. Or they might close off the review of the element altogether and not allow
further comments. In such scenarios, the review managers can set one or more status values at which an element under
review will be automatically locked against the posting of review topics and replies. According to the way the managers
want to progress elements through stages, the element under review might be assigned a subsequent status - or revert to a
previous status - that did not lock the element against review comments.

You set up the locking status for elements under review using the 'Review Status Locks' page of the 'Manage Model
Options' dialog. See the Review Status Locks Page Help topic. You can also examine the status locks on that page by
right-clicking on the Review view and selecting the 'Review Status Locks' option.

In the Reviews view, if an element under review is locked because of its status but it has not been fully approved, its
element-type graphic has a red circular icon overlaid by an exclamation point. If the item is expanded, it shows a
message under the element name and above the Approver names. These indicators are illustrated here:

4 &5 Create a review topic
!
]
as 2aron Brennan

2 Brendan Stoner
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Discuss & Review - History Window

The Discuss & Review History window provides a simple yet comprehensive summary of the Journal, Chat, Discussion
and Review messages sent and received in the model. Each category of message is presented on a separate tab, showing
details such as the name of the element under discussion, the date the message was posted, and in some cases the opening
text of the post. You can perform operations either on individual items or on the list as a whole, and double-click on an
item in one of the lists to display that item as the focus of the Discuss & Review window.

Access
Ribbon Start > Collaborate > Discuss > Discussion History
Start > Collaborate > Review > Review History
Start > Collaborate > Journal > Journal History
Start > Collaborate > Chat > Chat History
Start > All Windows > Collaborate > Histories > <appropriate option>
Keyboard Shortcuts Alt+3 > Histories > <appropriate option>

Ctrl+Alt+9 > <appropriate tab>

The Journals tab

The 'Journals' tab lists the elements across the model against which comments have been posted, showing details of each
element and the date on which the comment was posted.

On this tab, apart from using the context menu options described in the General Features table, you can also
double-click on an item to open its comments in the Discuss & Review window. You can then add to or edit text in any
comment posted on the element. You can also edit the comments in the preview pane, one of the features discussed in the
General Features table.

For further information on journal entries, see the The Journal Window Help topic.

The Discussions tab

The 'Discussions' tab shows the Discussions that have been recorded on elements across the model, listing the elements
under discussion and showing the text of the topic created against that element. Where there is more than one topic, the
element is listed again for each topic. The tab does not list discussions concerning diagrams.

On this tab, apart from using the context menu options described in the General Features table, you can also
double-click on an item both to open the Discussion topic in the Discuss & Review window and, at the same time, to
highlight the element under discussion in the Browser window. Note that the timeframe in the Discuss & Review
window must be able to accommodate the age of the posting; if you have listed Discussions from last month and the
timeframe in the Discuss & Review window is three days, the Discussion topic will not display.

For further information on Discussions, see the Model Discussions Help topic.

The Reviews tab
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The 'Reviews' tab shows the activity in Formal Reviews across the model, listing the items in which activity has
occurred.

Discuss & Review - History g x
Journals  Discussions  Reviews

[ Elernent Reviews Review Tapic Pasted By Posted Date  w Posted Tirme Topic Status Topic Priarity =
& Use Casel Heview sormething  Hoy Chillion Roy Chillion UL kA4l Upen

o2 Use Casel Owerall Review Ray Chillion Roy Chillion 27/05/2021 1753 Accept

E  Create an Elernent First Review-2lpha This is the first Review comment, the o... Roy Chillion 27/03/2021 1452 Open

Create an Element First Review-2lpha This Review elernent will accept coma, Roy Chillion 27/05/2021 14:51 Open

REQQ12Z - Provide Online Sales Rewiews - Take Or...  Roy Chillion Roy Chillion 25/05/2021 16:20 Alert

REQQ12 - Provide Online Sales Reviews - Take Or...  After raising a couple of points anthe .. Roy Chillian 25/03/2021 16:09 Open Mediurm

REQQ1Z - Provide Online Sales Review - Take Or...  After raising a couple of points anthe .. Roy Chillion 25/05/2021 16:08 Open Mediurn

REQI01S - Process Credit Card Payment  Review - Take Or.. s the system suppased ta accept &L .. Ray Chillion 25405/2021 1222 tpen Medium

AFARE Pl e oo e di P ead Frece ek Flaiens Tolo A loths ok e d b e AL ISR 96 RS A1 119 P Bl

On this tab, apart from using the context menu options described in the General Features table, you can also
double-click on an item both to open its Review discussion in the Discuss & Review window and, at the same time, to
highlight the element under review in the Browser window.

The information includes the name of the topic reviewer. Note that where the 'Review Topic' field shows a user name, it
indicates that the posting was to add that user as an Approver (effectively, the user name is the text of the discussion).
Also note that the 'Role' column identifies which items are Approver activities and which Reviewer activities.

For further information on Review discussions, see the Model Reviews Help topic.

The Chat tab

The 'Chat' tab lists the Chat conversations that you have been a party to. These conversations can be between yourself
and one other user, or those where you have participated in a Chat with one or more members of a user group. A user in
the Admin user group can open any other Chat user group and join the Chat of that group, without being a defined
member. So even though I'm not a member of, say, Team Green, if I am a member of Admin I can still join and review
that Chat group.

Discuss & Review History

Journals Discussions  Reviews Chat

Chat Group Date w Total Last Post Posted By Participants
4 Today
<8 Stephen Mega 12/08/2042 1127 Roy Chillion

4 Last Month

o Suthors 2r0as2022 %23 Steven Havana
4 Older

< Meil Crease 23/05/2022 13:55 Ry Chillian

<8 Hugh Loyd 12/04/2022 2:51 oy Chillion

g¢ Brad Briant 117032022 15002 Brad Briant

2 Howard Birkshire 3/0372022 15:22 Hawvard Birkshire
& Dermot Olsen 29/11,/2021 1444 Dermot Olsen

The 'Chat' tab defaults to the 'Summary' list (no timeframe), showing the last conversation you have had with each user
or user group you have communicated with, and the last of your correspondents to send or receive a post in that
conversation.

e  For a non-Admin user these Chats will be within the User Groups for which you are a defined member
e  For an Admin user the Chats will be from every User group

A red arrow next to the user's name indicates that the person sent you a message, and a green arrow indicates that you
sent a message to that person - the icons are very visible and enable you to tell at a glance which conversations might
require a response from you.

You can change the focus of the list by right-clicking on the panel and selecting the 'Visible Timeframe' option, and an
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option from the submenu. For an Admin user, the list of Chats is now confined to those groups that you are a defined
member of. The tab then shows the number of messages posted in each conversation - in the 'Total' column - and the
names of the participants and the number of posts made by each person - in the 'Participants' column. You can also
double-click on an item to display the complete conversation in the Chat & Mail window, as long as the window has
been set to display posts from the appropriate number of days in the past.

Both 'Summary' and 'Visible Timeframe' options will include recent Chats in conversations between single users.

For further information on Model Chats, see the Mode! Chat Help topic.

General Features

When the Discuss & Review - History window displays, it lists the items in which activity has occurred in date/time
order. On the tabs the items for today are listed first, in the Today group, followed in sequence by the items active This
Month, Last Month and earlier (Older).

The Discuss & Review - History window automatically refreshes after a short interval, which you define. You might
notice the window flicker when it refreshes.

The tabs default to displaying a number of columns, as shown in the earlier illustrations, but you can remove information
you don't need by dragging column headings out, and add information by right-clicking on the heading row, selecting the
'Field Chooser' option and dragging additional column headings into place. You can also filter the display according to
field value, and regroup the items by setting up a group and subgroup hierarchy in the Group Box. For more information
on tailoring the headings and content, see the List Header Help topic.

Option Description

Review Select this option to open the Discuss & Review window at the 'Review' tab and/or
load the selected element as the element in focus.

Manage Reviews Select this option to display the details of all reviews recorded in the model, in the
Reviews view.

Go to this Discussion On the 'Reviews' tab, this option opens the Discuss & Review window at the
'Review' tab and/or loads the topic thread for the selected element.

Alternatively, click on the item and press the Spacebar.

Discuss On the 'Discussions' tab, this option opens the 'Discuss' tab of the Discuss &
Review window and/or displays the discussion topics for the selected element.
Alternatively, click on the item and press the Enter key.

Open If the object under discussion or review is a diagram, this option opens the diagram
as a tab of the main work area.

Journal Entries On the 'Journals' tab, this option opens the 'Journal' tab of the Discuss & Review
window and/or displays the Journal entries for the selected element.

Edit Discussion On the 'Discussions' tab, select this option to display the Discussion in the 'Discuss'
tab of the Discuss & Review window. You can then set the priority or status, delete
a post or add a further discussion topic or response.

Chat This option opens the 'Chat' tab of the Chat & Mail window and displays the topics
for the selected Chat.

Properties Select this option to display the properties of the selected element under discussion
or review, in the 'Properties' dialog.
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Find in Project Browser This option locates and highlights the element in the Browser window.

Find in Diagrams This option locates and selects the selected element in any diagram in which it has
been used. If the element has been used in more than one diagram, the diagrams are
listed in the 'Element Usage' dialog and you can select from that list. The empty
dialog is also displayed if the element is not used in any diagram.

Visible Timeframe Select this option to display a short menu of numbers of days, from which you can
select a value to list items recorded up to that many days in the past. You can
therefore expand or reduce your list of posted messages.

The 'Summary' option is provided on the 'Chat' tab.

Check for Update Every This option displays a short menu of time options - 1, 2, 5 or 10 minutes - as the
interval between automatic refreshes to pick up new postings. Click on the interval
you want to apply.

On the 'Journal' tab, if you are working in a local or .qea file, this menu also has an
'Enabled' option that you select to allow refresh of the Journal list, or de-select to
prevent refresh of the list.

Show by Status On the 'Reviews' tab, select this option to list either all the Review comments (the
'All' sub-option) or only those against elements having a selected element status.

When you select the 'Configure' option, a dialog displays listing all the possible
status values for the element. Click on the checkbox against each status value you
want to filter the displayed items for. You can click on the Select All or Clear All
buttons to select or clear all checkboxes and reset one or two of them.

When you have made your selection, click on the OK button to filter the elements
under review.

Filter Approvals On the 'Reviews' tab, select this option to set or clear a filter on the list of Reviews
according to the assignment of Approvers to the review items. Select:

e Approvals Only - to list only items that have assigned Approvers
e My Approvals - to list only items where you are an assigned Approver
e Hide All Approvals - to hide all items that have assigned Approvers

e No Filter - to remove the filter and list all items, with or without assigned
Approvers

You can set filters on topics and approvers at the same time.

Filter Topics Select this option to filter the list of topics to show only your own topics, or all
topics except your own. If you have set one of these options, you can also select an
option to remove the filter.

You can set filters on topics and approvers at the same time.

Show All Posts On the 'Reviews' tab and 'Discussions' tab, select this option to show all
Discussions posted, not just the most recent one.

Show Preview Pane Select this option to open a pane on the left or right of the window, or at the bottom
of the window, displaying the text of the currently-selected review topic, discussion
thread or Journal item. As you click on different items in the window, the text in the
pane immediately reflects the new selected item. You can also hide the preview
pane if you no longer need it.

You can edit comments that you have created previously, in the preview pane as
well as in the Discuss & Review window.
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Refresh This option will refresh and redisplay the currently-selected tab of the Discuss &
Review window. You can also press F5 to refresh the contents of the window.

Set This Tab as Default Select this option to set the Discuss & Review History window at the current tab to
automatically redisplay when you log back in to the model in a new work session.
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Model Chat

The 'Chat' tab on the Chat & Mail window provides an extremely useful facility of following and participating in quick
conversations on a point of interest, with members of a selected user group. The user group can contain a number of
users and is defined in User Security, which must be enabled in order for the Chat facility to be available.

You can also select an individual user to chat with; each model user - also as defined in User Security - is nominally a
Chat group of one.

Each initial comment or response is a separate message, listed in date/time order, with the most recent message at the top
of the list. The messages are independent of the currently selected model object and the full list displays whenever the
user group is selected in the 'Chat' tab. As the messages are independent of any model object, they do not appear in the
'"Recently Discussed Elements' report, which is element-based.

If you simply want to make notes for yourself, you can use the "My Diary' tab on which you jot down any notes,
comments, reminders or references that you want to record during the day. Alternatively, you can make similar notes
about a specific element, and effectively chat with other users about that element, through the 'Journal' tab of the Discuss
& Review window.

You can filter the messages by the time interval prior to today, and you can set up a check to notify you when new
messages are posted by members of one or more user groups, including specifically-selected individual users.

This screen capture shows an example of a Chat session:

Chat & Mail v 1 x

Chat Model Mail My Diary

“

= Hugh Loyd

o

Actually, the conversation reappeared when [ switched the Visible Timeframe option to 'all'. Sophia's notes were not
far away 501 read them myself and there are no mentions of the type of problem you describe, not in the Notes,
Inspector, Discussions, Reviews, Journals or Chats, vou are probably better able to describe exactly what the problem
iz, &0 [ have asked her 1o give you a call - she is still local.

Send

bk

Roy 20 sep

v
1740 Hugh, remember this conversation? (You can search for it using the Commaon Searches > Find Model Chat search).
One user cannot wark on the system while another particular user is logged in - other users neither have nor cause
the praoblem,. I want to check through Sofia's notes and see if that ever happened with her.

A | Hugh 20052020

u
£
£

544 Ch - a bit later than I thought, How about 9:00 tormarrow morning then?

1536 Sofia has come up with an interesting solution 1o the problerm we had with simultaneous access by remote users,
I'll snd it aver by email and if you are free in a couple of hours we can talk about it on the vidlink,

Access
Ribbon Start > Collaborate > Chat > Chat
Start > All Windows > Collaborate > Personal > Chat
Context Menu Browser window > Right-click on element > Collaborate > Chat
On diagram > Right-click on element > Collaborate > Chat
Keyboard Shortcuts Alt+3 > Personal | Chat
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Select a User Group

Initially, the button at the top of the 'Chat' tab displays the name 'Select a Discussion Group'. Click on the button and, if
you want to communicate with:

e A group of several users, select the 'Group Chats' option and the name of the user group to send messages to

e A specific user, select the 'User Chats' option and either the name of a user you have already been chatting with
previously, or the 'Select Chat Group' option to locate the specific user (on the 'Create New Discussion' dialog, click
on the With button, double-click on the name of the user in the displayed list, then click on the Create button)

The name of the currently-selected user group or user then becomes the name of the button.

If you want to communicate with a different group or user, click on the button again and select the group or user to chat
to, as before.

If you do not want to continue chatting, you can select 'Disconnect from Current Chat'.

Create a Message

Step Description

1 At the top of the 'Chat' tab, in the text field, create your message. You have two
options, direct entry or indirect entry.

In direct entry (better for short messages), type or paste your message as continuous
text (no carriage returns). The text automatically wraps at the border of the text
field. As you type, you can right-click on the text and perform the usual Notes text
operations such as formatting and setting translation flags.

If you need to break your text into paragraphs, press Ctrl+Enter at the point at
which to break the text.

In indirect entry, press Ctrl+Spacebar in the field to display a simple text window
and type or paste your Chat text there. When you have finished your message, press
the Esc key to transfer the text to the 'Chat' tab. The advantage of the indirect
method is that you can edit and format the text - especially in long messages
containing several paragraphs - without risk of accidentally submitting it
incomplete as a Chat item.

Note that your text might contain words that are automatically underlined. These
are terms for which a Glossary definition has been created, and positioning the
cursor over one of these words will display the definition in a pop-up message box.
If you do not want to indicate glossary terms, right-click on the message and click
on the 'Highlight Glossary Terms' menu option. This will clear the automatic
underlines across the system. Do this again if you want to restore the underlines.

2 Whilst you can add quite a lot of text to a Chat message, you might need to send a
larger volume of already-existing text or information in another format such as a
chart or graphic file. You can do this very simply while you are typing, by
right-clicking at the appropriate point in your text and selecting:

e 'Insert Document', to display a file browser to locate the document in your file
system, or

e 'Insert Link to Existing Document', to display the 'Manage Chat Documents'
dialog and select a document that has already been attached to another Chat
message

e 'Paste Image as Internal Document', to insert a link to an image previously
copied onto the clipboard, such as an image asset from a diagram or a screen
capture using the Print Screen button
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After the document link is inserted, you can continue typing the rest of the Chat
message.

3 When you have completed your message in the text field, click on the Send button
or press the Enter key. The message displays at the top of the list underneath the
text field.

If you have selected to show avatars (the 'Settings > Security > Administer > User
Settings > Show user avatars' ribbon option), all messages show an image
representing the user who contributed that message. If a user does not have an
avatar image, a default 'head and shoulders' silhouette displays as the avatar.

Also, if you are chatting with members of a user group, your names are shown in
full. If you are talking to a single user, only your first name displays. There might
be more than one Steve or Dave in your user group, so the surnames identify which
is writing. In a one-to-one Chat you specifically chose to talk to, say, Dave
Brookes, so the surname is not necessary.

Review Messages

Messages you have sent or received are listed in the body of the 'Chat' tab in chronological order, with the most recent
message at the top. If you post messages in succession, without response from another user, your messages are grouped
together in time order with the most recent at the top, and the time it was sent on the left. If the set of messages spans
more than one day, the date of posting is also displayed.

In a Chat with another individual user, the messages from each person have highlighted backgrounds, so that you can
quickly see where each user's message(s) start and finish.

Once a message has been sent, it cannot be edited. If you want to re-use the text of a message item, you can copy some or
all of the message to the clipboard by pressing Ctrl+C before you send it. You can then paste the text into a new chat
item or into another document in Enterprise Architect. Alternatively, you can copy the whole message by right-clicking
on it and selecting the 'Copy' option.

You can also delete a message by right-clicking on it and selecting the 'Delete Message' option.

Messages sent by other people to the currently-selected User Group display in your screen immediately. Messages
deleted by other users do not disappear immediately. To update your list, right-click on it and select the 'Reload
Messages' option.

Reply to a Message

The menu option "Reply to..." is available in the context menu when you right-click on a message in the chat window.
Selecting this option opens the chat editor, and automatically includes the text of the message you're replying to, prefixed
with "RE: <UserID> <time date>", ensuring full context is provided. When you have finished composing your reply,
close the chat editor by pressing 'Esc' or by clicking the 'X' in the editor's title bar. Your reply message will appear in the
chat window. Finally, click the 'Send' button to post your reply.

Alternatively, you can achieve the same result by typing '<>' at the start of your reply message, follow with your reply
text, and then select the post you are replying to prior to clicking the 'Send' button. Again, the text of the message you
are replying to, prefixed by "RE: <UserID> <time date>" is included in the reply message.

If you type >' at the beginning of your message, when you click 'Send', instead of posting a new message, the new text
will be appended to the last message that you sent. This is helpful if you forgot to include something and want to add it
to your previous message rather than send a new one.
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Chat & Mail o x
Chat Model Mail My Diary
= NPCs _e
Send
:.. Lance Link =
15:34 | can take on that task if you need it done this week.

RE: Philip 15:28 18 Oct

Jerry, | have just written up test cases for all of the new features. Can you please verify the
functionality against the tests?

> Please amend the tests if there is anything | have left out.

Jerry Mander

i Ee

[
Ln

Phil, Il won't have time to look at the tests until late next week.

Philip Buster

Jerry, |have just written up test cases for all of the new features. Can you please verify the
functionality against the tests?

5 Bo

[
in

> Please amend the tests if there is anything | have left out.

Monitor User Groups for Messages

You can set the system to monitor selected user groups, and to notify you when a member of one of those user groups
posts a message whilst the 'Chat' tab is either set to a different user group or not visible. A member of the 'Administrators'
user group can add themselves to any other security group and receive notifications of posts to that group.

Note that you do not have to manually set monitoring for Chat messages posted under the IDs of individual users; these
are all monitored automatically.

The notification is a | ® M58 | hat displays at the right of the application title bar when a message is posted from a
monitored user group. The button also displays if a message is posted in the thread you have been reading, and the 'Chat’
tab is not visible. If you still have the thread loaded in the 'Chat' tab, click on the button to redisplay the 'Chat' tab with
the new message in the thread.

The Msg button also provides a menu to indicate which group has posted the new and unread message. When you click
on a group in that menu, the 'Chat' tab displays with the appropriate thread of messages.

To set up a check for messages from a user group:

1. Click on the 'Options' icon 5% on the right of the header of the 'Chat' tab, and select the '"Monitor Groups for new
Messages' option.

2. Select a user group to monitor. If you want to monitor more than one group, either:
- Do steps 1 and 2 again for each individual group to monitor, or
- Select the 'All' group to check for messages from any group

3. Select the 'Monitor Groups for new Messages' option again, and click on the 'Check for new Messages Every' option.
Click on the interval of time at which the system will check for new messages - every minute, or up to every ten
minutes.

4. If you want to cancel monitoring a specific group, repeat steps 1 and 2. Clicking on a selected group will deselect it.
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5. If you want to cancel monitoring all of the selected groups, perform step 1 and then click on the "None' option.

You can also set up a concise and very responsive mechanism on a diagram to notify you of Chat messages sent to you.
For further details, see the Collaboration Support in Diagrams Help topic.

Filter Messages by Age

The 'Options' icon provides a series of options to limit the display of messages to those posted within a certain number of
days prior to today's date.

You can select to display only messages posted today (the default), or within the last 3, 7, 30 or 90 days. The 'Today +'
option also enables you to show postings from today and the 20 most recent postings prior to today

If you do not want to limit the display of messages to an interval you have set, you can cancel it by selecting the 'All'
option.

These options are also available if you right-click on the message list and select the "Visible Timeframe' option.

Searching the Chat Messages

The 'Chat' tab of the Chat & Mail window also provides a facility for searching through the messages for a specific text
string, and for filtering the messages to those between a certain pair of dates. For information on this facility, see the
Search Within Chats Help topic.
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Managing Chat Documents

An aspect of exchanging Chat messages about any aspect of the project is attaching related documents and similar files
to a message. At any point, you might want to check what documents you have sent and/or received and perhaps perform

some management function on them. You can do this through the 'Manage Chat Documents' dialog.

X
Manage Chat Documents

IManage all stored documents in the model that have been sent or received via chat.

Currently showing zent documents for any chat,

Marme

HelpPage-Weh, html

Recipient Type Size Created w
Hugh Loyd it 14 kb 2143 P

Options v
Access
Ribbon Start > Collaborate > Chat > Chat > Right-click on body of 'Chat' tab | Manage

Chat Documents

Context Menu

Right-click on body of Browser window | Collaborate | Chat | Right-click on body
of 'Chat' tab | Manage Chat Documents

Dialog Fields and Options

This table explains the fields and buttons presented on the '"Manage Chat Documents' dialog.

Option

Description

Currently showing ...

A message indicating what filters and limits have been set on the display. The first

documents ... part of the display reads either:
e  Currently showing sent documents...  or
e  Currently showing received documents...
The second part reads either:
e ... documents for any chat or
e ... documents limited to the active chat
Name Displays the name of the document attached to the Chat message.
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Sender/Recipient Displays the user name of the person who sent the Chat message containing the
document to you, or received the message containing the document from you

Type Displays the file type of the document.
Size Displays the file size of the document.
Created Displays the time and date the Chat message containing the document was created

(and effectively sent).

Options Click on this button to display a list of options for filtering the display and
managing the Chat documents. These options are the same as the context menu
options for the dialog, as described in the next table.

Context Menu Options

This table describes the menu options listed when you either right-click on the dialog display or click on the Options
button.

Option Description

Load Document Opens the appropriate internal or external viewer to display the contents of the
selected document.

Save As Displays a browser dialog that enables you to save the selected document as a
different file in the appropriate location.

Detach Removes the selected document from the Chat message but not from any internal
location it is stored in.

Filter To Displays the two options to show documents either sent by you or received by you.
Click on the appropriate option.

Limit To Displays the two options to show either all documents attached to any Chat
messages in the 'Chat' tab, or just those documents attached to the
currently-selected Chat message.

Delete Removes the selected document from the Chat message and from the model.
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Search Within Chats

Within the 'Chat' tab of the Chat & Mail window, you can selectively search for historical Chats, filter the currently
displayed Chats and show Chats for a specific time period. These options are available through the Search/Filter bar,
which you can toggle on and off using the 'Toggle Filter/Search Bar' option in the context menu or the Toolbar Options
button on the far right of the window.

The default behavior is to filter the displayed items based on the search term supplied. You can apply a filter or run a
search by pressing the Enter key when the Search/Filter bar is active, or by clicking on the Spyglass icon on the far right
of the bar.

To search historical Chats you must specifically choose that option each time you want to run a search. After the results
are returned the Search/Filter bar becomes a filter again, so you can further filter the returned results.

Search/Filter Bar Options

—
—
—

Clicking on the button to the left of the Search/Filter bar provides the options described here.
Option Description
Search Open Chats This is the default behavior; this option will load up all the active Chats and filter

the displayed items to those containing the term supplied. For example, if you
choose to filter on date/time or search historical Chats, choose this option to revert
to the latest conversation and filter on those displayed results.

Search Chat History This option places the Search/Filter Bar into a 'once-off search' mode that will
search for the specified term across all Chats for the active Chat group. After the
search is run, the Search/Filter bar reverts to filtering on the displayed Chat results;
that is, further filtering your search results.

To run another search across all Chats, simply choose the option again. You can
cancel running a search by pressing the Esc key, selecting the 'Search Open Chats'
option, or reloading the window.

Show Chats for a Specific Selecting this option allows you to show all conversations between two chosen
Timeframe dates.

When you click on the option, the 'Show Chats by Date' dialog displays.

Show Chats By Date =

Dizplay all chatz between the following dates where
'From:" iz the earliest and 'To:' iz the latest,

From: 0490202z -

Ta: 04102022 E

Cancel

If a Chat is currently selected in the window, the start date is that of the selected
item, which can be helpful after running a search if you want to read all the
conversations from that day forwards. Click on the drop-down arrow to the right of
the 'To' field (and, if necessary, the 'From' field) and select the required date.

Note: This option is also available via the right-click context menu on the Chat list
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control.

Clear If you have
e Applied a filter, this option removes the filter and shows all items
e Just run a search, this option clears the search and shows the current items

e Run a search and then applied a filter, this option removes that filter; selecting
'Clear' again removes the search and displays the current Chats for the
connected group

Additional Context Menu Options

After you have run a search or filtered to a specific time frame, the right-click context menu will contain these additional
options.

Option Description

Show Full Day Displays all conversations on the same day as the selected Chat. The selected Chat
will remain highlighted and visible to help provide context.

Show Context - 4 Displays the next two Chats either side of the currently selected item. This is
helpful when you want more context around the current Chat before taking further
action. For example, after running a search you might want to select an item and see
all the Chats on that given day, but you aren't quite sure if this Chat is the one you
are looking for. You can use this or the 'Show Context - 10' option to provide more
context around the given search result.

Show Context - 10 As for 'Show Context - 4', but this option shows the next 5 Chats either side of the
currently selected item.
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Model Mail

The Model Mail facility provides you with the ability to send, receive and respond to emails within the project team,
under your User Security ID, either as an individual user or as a member of a group that has a shared mail inbox. The
'Mail' tab of the Chat & Mail window shows all emails that you have received, and the 'Sent Messages' tab in the main
view shows all the emails you have created and sent. Within the facility you can re-organize, forward, delete and mark
the emails, both sent and received.

This facility is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect, with User Security
enabled; the mail system uses the individual and group users defined in User Security.

Access

Ribbon Start > Collaborate > Mail > Inbox
Start > Collaborate > Mail > Sent Mail
Start > All Windows > Collaborate > Personal > Mail

Review your Model Mail Messages

If you already have the 'Mail' tab of the Chat & Mail window open, you will notice new, unread messages in the list,
displayed in bold.

Otherwise, when a new mail message arrives in your inbox, the ® M9 Jicon will display in the top right corner of the
screen. When you click on that, a list displays identifying that you have x number of unread Mail messages and - if
appropriate - x number of unread Chat messages. Click on the Mail message item to open the 'Mail' tab and reveal your
unread mail messages.

Option Action

Open a message Double-click on the message.

If the message contains a hyperlink, click on the link to open or display the target
file or object.

Flag Check the color of the flag to the left of the message to establish the significance of
the message (the meanings of the flag colors should be defined within the project
team).

Status

Check for the read ( —rl) or unread ( = ) icon; unread message items are anyway
displayed in bold. If you have responded to a message, the icon includes a green

arrow ( % ).
Sender The name of the project team member who sent the message.
Subject The topic of the message.
Date Indicates the age of the message, whether it was sent:

e Today
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e  Yesterday
e  This week
e This Month
e Last Month

e Older
Sent The exact date and time the message was sent.
Select Columns Right-click on the column headings and select the 'Field Chooser' menu option,

which enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Adding the 'To' column will display the user account or group name that this mail
item was sent to; this column is useful to identify whether the message was sent to
you as an individual or as a member of a Group with a Shared Mail inbox - if you
received the message as a member of a shared mail group, remember that your
actions on this message will also affect all other members of this group.

Filter Columns You can filter the mail items listed by displaying the Filter Bar (right-click on the
column headings and select the 'Toggle Filter Bar' option) and typing in the value
(or partial value) to filter on.

For example, if you type your group mail account name in the filter field for the 'To
column, you will list only those mail items sent to the group mail address, not those
sent to you as an individual.

To clear the value of a filter field, click on the blue cross against that field.

Reorganize messages in the Either:
list e  Click on a column heading to toggle sorting of list items by this column in
ascending or descending order, or

e Right-click on the column heading and select the 'Enable Group Box' option to
organize the messages into groups

Model Mail Menu Options

These options are available from the context menu when you right-click on messages in the body of the tab.

Option Action

Compose New Message Click to open the 'New Message' tab in the main work area, through which you
create and send a mail message. Alternatively, if you have selected not to use the
main work area, the 'Model Message' dialog displays (see the 'Edit Messages in
Main Tab View' option later in this table).

You can also open the tab or dialog using the 'Start > Collaborate > Mail > Send
Message' ribbon option, or right-click on an element in the Browser window or a
diagram and select the 'Collaborate | Send Message' option.

Reply Create a response to the sender of the message, which includes a copy of the
message and any earlier messages in the thread. If you have left the 'Edit Messages
in Main Tab View' option selected, the '<message subject>' tab opens in the main
work area; otherwise, the 'Model Message' dialog displays.
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Shortcut: Ctrl+R

Reply to All Create a response to the sender of the message and the other recipients, which
includes a copy of the message and any earlier messages in the thread. If you have
left the 'Edit Messages in Main Tab View' option selected, the '<message subject>'
tab opens in the main work area; otherwise, the 'Model Message' dialog displays.

Shortcut: Ctrl+Shift+R

Forward Forward the message to other project team members with, if necessary, your own
comments. If you have left the 'Edit Messages in Main Tab View' option selected,
the '<message subject>' tab opens in the main work area; otherwise, the 'Model
Message' dialog displays.

Shortcut: Ctrl+F

Set Message Flag Select the appropriate flag color to establish the significance of the message (the
meanings of the flag colors should be defined within the project team).

You can also select:

e Complete - to display a tick next to the message, indicating that any actions
required by the message content have been taken

e None - to display only a grayed outline of the message flag, with no status
color or 'complete' tick

Mark as Unread Mark the selected messages as unread.
Shortcut: Ctrl+U

Mark as Read Mark the selected messages as read.

Shortcut: Press Ctrl+Q, or click on the message and press the R key.

Check for New Messages Refresh the message list to include any new messages waiting in the message
queue, which would otherwise not display until the automatic refresh cycle has run.

Shortcut: Ctrl+F5

Limit Mail Items To Click on this option to display a short list of time intervals - 30, 60 or 90 days - and
select one to filter the list of Mail messages to those received during that interval.
Select 'All' to remove interval filtering from the list.

Show Preview Pane Select this option to show the content of a selected message in a panel either to the
right or beneath the list of Mail messages, according to the sub-option you select.
Click on the 'Hide' sub-option to close the preview panel.

Open Sent Messages Click on this option to open the 'Sent Messages' tab in the main view of the
Enterprise Architect work area, listing the messages you have created and sent.

You can also display the 'Sent Messages' tab by selecting the 'Start > Collaborate >
Mail > Sent Mail' ribbon option.

Edit Messages in Main Tab Defaults to selected to display the 'New Message' tab in the main work area, in

View which you compose a new message, a reply to a message sent to you, or an
annotation on a message you are forwarding to someone else. Deselect this option
to open the free-floating 'Model Message' dialog in which you perform the same
functions.

Delete Delete a selected message or messages; you are prompted to confirm the deletion.
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Manage Your Sent Messages on the Sent Messages Tab

Option Action

Open a message Double-click on the message.

From the open message you can reply to yourself (perhaps to annotate what you
sent to the recipients), reply to yourself and all other recipients (to quickly add
more information for the same mail list), or forward the message to other team
members, using the appropriate icon in the toolbar of the message.

Flag Check the flag color to establish the significance of the message (the meanings of
the flag colors should be defined within the project team).

To Check the name(s) of the project team member(s) to whom the message was sent.
Subject The topic of the message.
Date Indicates the age of the message, whether it was sent:

e Today

e  Yesterday
e  This week
e Last Week
e This Month
e Last Month

e Older
Sent The exact date and time the message was sent.
Sender Show the name of the person who sent the message; that is, either you as an

individual or a member of your user group.

Select Columns Right-click on the column headings and select the 'Field Chooser' menu option,
which enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Adding the 'Sender' column is useful to identify whether you have sent the message
as an individual, or as a member of a shared mail group.

Reorganize messages in the Either:

list e  Click on a column heading to toggle sorting of list items by this column in
ascending or descending order, or
e Right-click on the column heading and select the 'Enable Group Box' option to
organize the messages into groups
Reply to All Right-click on the message and select the 'Reply to All' context menu option to send

a further email to yourself and the recipients of the message

The 'New Message' tab of the main work area, or the 'Model Message' dialog,
displays.
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Shortcut: Ctrl+Shift+R

Forward Right-click on the message and select the 'Forward' option to send the selected
message to other team members.

The 'New Message' tab of the main work area, or the 'Model Message' dialog,
displays.
Shortcut: Ctrl+F

Delete messages Right-click on the message and select the 'Delete’ option.

You are prompted to confirm the deletion.
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Create a Message

You can use the New Message' tab of the main work area, or the 'Model Message' dialog, to compose messages to
project team members within the project, under your Author ID. You use the same tab or dialog to:

e Reply to messages from other team members
e  Forward messages to other team members
e Link model components to the message, or add hyperlinks to files or other objects of relevance

The New Message' tab displays if the 'Edit Messages in Main Tab View' option is selected on the 'Mail' tab (intray) of
the Chat & Mail window. The 'Model Message' dialog displays if that option is not selected.

Access

Ribbon Start > Collaborate > Mail > Inbox
Start > Collaborate > Mail > Sent Mail
Start > All Windows > Collaborate > Personal > Mail
Start > Collaborate > Mail > Send Message or

In a diagram or the Browser window, click on an object (or select several objects),
then Start > Collaborate > Mail > Send Message with Link

Context Menu In a diagram or the Browser window, right-click on an object (or select several
objects) | Collaborate | Send Message

Create a New Message or Reply to a Message

Step Action

1 If you have selected one or more elements before selecting the context menu 'Send Message' option or
ribbon 'Send Message with Link' option, the message editor screen immediately displays with links to
each selected object. The recipient of the message will be able to press Ctrl and click on each link to open
the 'Properties' dialog for the corresponding object.

2 Otherwise, the 'Mail' tab of the Chat & Mail window displays. Select the appropriate context menu option
to create or open and reply to or forward a message.

The message editor screen displays.

3 If you are creating or forwarding a message, or you want to send a reply to a wider audience, for each
person you intend to send the message to:

e  Click on the To: button
A list of project team member and group IDs displays

e  Scroll to the required name and double-click on it
The name is added to the 'To:' field

4 In the 'Subject' field, type or edit the subject of the message as necessary.

In the 'Flag' field click on the drop-down arrow and on the appropriate flag color or option for your
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5 message.

6 In the text panel, write the text of your message.

You can format the text using the facilities of the 'Notes' toolbar at the top of the field.

7 If you intend to link a (further) diagram or model object to this message, place the cursor at the
appropriate position in your message text, click on the object in the Browser window, and click on the
Insert Quick Link button.

A short menu displays, listing the name of the object you have selected or 'Other' to search for and select
another object. To link to the object you selected, click on its name; a hyperlink to that object is inserted
in the message text.

8 If you intend to link to some other object, or you want to link to another target such as a file, Model
Search or Library message, click on either:

e The 'Hyperlink' icon in the message (or Notes) toolbar or
e  The Insert Quick Link button and select the 'Other' option
The 'Hyperlink Details' dialog displays; create the required link.

9 Click on the Send button to send the message to the recipients.

Notes

e  This facility is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect, with User Security
enabled (Security provides the user names to address your mail message to)

e Once you have sent a message, it is listed on the 'Sent' tab in the main work area; in the 'Mail' tab, right-click and
select 'Open Sent Messages' to display the 'Sent' tab

e Your text might contain words that are automatically underlined, these being terms for which a Glossary definition
has been created - positioning the cursor over one of these words will display the definition in a pop-up message
box; if you do not want to indicate glossary terms, right-click on the text and click on the 'Highlight Glossary Terms'
menu option to clear (and restore) the automatic underlines across the system
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Your Model Workbench

Enterprise Architect provides a great facility for maintaining a personal daily Workbench, in which you can type all
kinds of ideas, comments, notes, suggestions, events, to-do lists and other reminders of what you have done or intend to
do within the model. This is a good way to keep the momentum flowing day to day. The facility is simple to use,
allowing you to quickly jot down your thoughts as they occur to you.

The ™y Workbench' tab is part of the Chat & Mail window, which allows you to take notes as you engage in formal or
informal discussions and chats with other team members, as well as during your work on other screens and dialogs.

Because the Workbench entries are specific to your login, this facility is only available within a model for which User
Security has been enabled.

Access
Ribbon Start > Personal > My Workbench
Start > All Windows > Collaborate > Personal | My Workbench
Keyboard Shortcuts Alt+3 > Personal | My Workbench

Creating the first Workbench Entry

When you first access the "My Workbench' tab, it has the single entry 'Today' in the 'Date' column. You can type freely in
the 'Workbench' column against 'Today', including carriage returns and text formatting. Right-click on selected text to
access the editing options, which include:

e Creating a Glossary definition from the text, and inserting existing definitions in the text
e Generating a new element in the same Package, with the selected text as the name and linked to the text
e Creating a link from the selected text to an existing element in the model

e C(Creating a hyperlink to a wide range of target objects, including image files, diagram images, web pages, text files,
Help topics and Enterprise Architect commands

e Marking selected text for special translation, or to be omitted from automatic translation

e  Searching for instances of the selected text in a range of sources (options derived from the 'Code Editor' context
menu)

e  Undoing the latest change to the text

e Editing the text, with cut, copy, paste and delete, selecting all the Diary entry text entered for a day, setting fonts,
and setting paragraph format

e  Printing the selected text, and checking meanings and synonyms using the online Thesaurus

e  Either highlighting terms that have been defined in the Glossary, or turning highlighting off

When you have finished typing your note, click off that entry.

You can return to the Workbench entry at any time and:

e Add further notes; you use the same entry to record all your notes and comments on the element throughout the day
e  Edit the existing text, including reformatting

e Delete text or complete notes; select the text and click on the Delete key or use the 'Delete' context menu option

(c) Sparx Systems 2025 Page 74 of 119 Created with Enterprise Architect



Teams & Collaboration 2 September, 2025

Workbench Entries Each Day

Every day, when you open Enterprise Architect and the 'My Workbench' tab, it has a 'Today' item at the top, against
which you record the day's Workbench entries. Beneath the '"Today' item are the entries for previous days, identified by
the date on which you made them. This only lists dates on which you have made an entry; there are no blank lines for
days on which you did not make an entry.

As well as formatting and editing today's entry, you can edit the entries for previous days. This means you can remove
information that is no longer relevant (such as old reminders) or things you listed to be achieved that you have now
completed. On the other hand, you can also highlight entries that are still significant, and refer back to them from the
'"Today' entry.

To help you review your Workbench entries, you can show all the entries you have made or restrict the list to the last 1,
3,7, 15 or 30 that you made. To set the number of entries, right-click on the body of the 'My Workbench' tab, select the
'Show this many entries' option and click on the required number.

Push Text

The "Push Text' facility enables users to push text content from numerous different application windows into the
Workbench window, or from the Workbench window into the Notes of a currently selected model element.

Chat & Mail m

Chat Model Mail My Workbench

Date * Workbench -
Today Enterprise Architect provides a great facility for
ma A ’ B n tune
a Push Text to Motes of Current Item
tO-1 o _ . Push Text t
ot Show This Many Entries 4 Current Ite
the Save Diary to File r
USE as
the Refresh
Copy to Clipboard
Jul 07
Help
w

It is possible to push text into the workbench window from all three tabs of the Discuss & Review window, the Chat
window, as well as the pop-up editor windows displayed by pressing "Ctrl+Space", either for a posting in a Chat window
or for the Notes of a model element.

This feature is designed to enhance productivity by enabling quick reuse or relocation of important information captured
in journal entries, without the need for manual copy and pasting.

In all cases, the facility is invoked by right-clicking on an entry, then choosing the appropriate menu option. The menu
option will be one of the following;

e  Push to My Workbench
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e  Push Text to Notes of Current Item
e  Push Text to > My Workbench
o Push Text to > Notes of Current Item"

Note: At present, this functionality supports only notes on elements. Support for notes on additional types may be
considered in future updates.
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The Model Library

If the project team members require a forum in which to discuss the development and progress of the project - including
holding documents such as specifications, requirements and project guidelines - they can make use of the facilities of the
Enterprise Architect Library window.

Access

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Features

Feature Description

Structure A point of discussion and the responses (Comments) to that point are created as
Documents. Documents are held in Topic groups, which are in turn organized into
Categories; your organization decides on the grouping and organization of
Documents.

You can create text to explain Categories and Topics, and you can create and
respond to Documents and Comments on Documents.

Displays The Library window has two main displays:

e The Library window itself is used to create new Categories and Topics and to
delete messages; you operate on it by selecting options from the context menu
Each item in the hierarchy displays a mouse-over tool-tip, showing the item
title, the author's name and the date and time the item was created

e The 'Team Document' tab, in the main work area, is used to create, view, edit,
print, and comment on Documents, and to create and maintain the descriptions
of Topics and Categories
This tab has a status bar that shows the item author's name, the date and time
the item was created, and the date and time the item was last modified

Facilities Within the Library window you can:

e Select to display and edit an item in the "Team Document' tab, by clicking on
the item name in the Library window

e  Search for text strings in the item titles to locate Documents on a specific
subject, using the 'Search' icon in the toolbar of the Library window

e Add resources to a Category, Topic or Document, such as diagram images and
XMI files of Packages; these are held in a Resources folder under the selected
Library item

e Link model elements, diagrams, external files and other Documents to a
Document

e Link to a Library Document from the Linked Document on an element

e Change the loading behavior of the Library window
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Access Libraries from other projects, including those on other servers

The Library window acts as a repository for the review documents generated in the
Specification Manager. These documents are automatically stored in Topics within
the Formal Reviews Category, but you can redirect documents to a different Topic
from the Library window, using the 'Bind to Project Browser Package' option.

Each item in the Library window has an icon that indicates the nature or status of
the item. The meaning of each of these icons is explained here:

D - Document name

IE - Comment name

! - Protected by password (also on Category and Topic icons); a blue icon
indicates that a user with the password has opened the item, and a red icon
indicates that the item is locked

B Status 'Awaiting Approval' (also on Category and Topic icons)
- Status 'Approved' (also on Category and Topic icons)

. Status 'Rejected' (also on Category and Topic icons)

=. Category name

- Topic name

= Resources folder for a Category, Topic or Document

S Linked objects folder for a Category, Topic or Document

=] Diagram or clipboard image within the Resources folder

& - XM file of a Package, within the Resources folder

e  You can transport your Library set-up between projects, using the 'Settings > Model > Transfer > Export Reference
Data' and 'Tmport Reference Data' ribbon options
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Work on Library Items

Within the Library window, you can perform a wide range of operations on the Documents and the Topics and
Categories that contain them. These operations include creating an item, commenting on a Document,
password-protecting an item so that it is not accidentally changed, accessing protected items, adding resources to an
item, and deleting an item. All of these operations are accessed through the context menu in the Library window.

Access

Open the Library window using one of the methods described here, then right-click on an item

Ribbon

Keyboard Shortcuts

Library Options

Option

New Category
New Topic

New Document

New Category From
Template

New Topic From Template

New Document from
Template

New Comment

Rename

Copy Path to Clipboard

Show Contents

Share Resource

(c) Sparx Systems 2025

Start > Collaborate > Model Library

Ctrl+Alt+U

Action

Add a new Category, new Topic or new Document to the Library window.

Alternatively, click on the New Topic' or 'New Document' icon in the window
toolbar.

Add a new Category, new Topic or new Document, based on a defined template.

Create a response to the selected Document.

Alternatively, click on the New Comment' icon in the window toolbar.

Edit the name of the currently-selected item, in situ.
Shortcut: F2

Copy the path of the currently-selected item to the clipboard.

You can then paste the path into a document or file to add the discussion to any text
concerning the item.

Shortcut: Ctrl+C

Display the description or text of the item selected from the Library window, if the
'"Team Document' tab is not yet open.

(If anything other than a Resources folder is selected.)

Add an item into the Resources folder under the selected Category, Topic or
Document. If a Resources folder does not exist, one will be automatically created.
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Add Package From Current
Model

Import to Current Model

Image of Active Diagram

Active Profiler Report

Image From Clipboard

View Image

Copy Image To Clipboard

Refresh Category 'xyz'
Refresh Topic 'xyz'
Refresh Document 'xyz'

Refresh Comment 'xyz'

Reload Current Connection
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Available options:

e Package from Current Model
e Image of Active Diagram

e  Active Profiler Report

e Bookmark Active Website

e Image from Clipboard

(If a Resources folder is selected.)

Export a Package as an XMI file from the current model as a resource of the
selected Category, Topic or Document.

You browse for and select the required Package using the 'Select <item>' dialog.

(If a Package XMI file resource is selected.)
Import the resource Package to the current model.

You browse for and select the required target Package using the 'Select <item>'
dialog; the resource is imported as a child of that Package.

This is a useful option for transferring relevant Packages from the Library of one
model into another model.

(If a Resources folder is selected.)

Add an image of the currently-displayed diagram as a resource of the selected
Category, Topic or Document.

You are prompted to provide a reference name for this image.

(If a Resources folder is selected.)

Add an active Profiler Report as a resource of the selected Category, Topic or
Document.

You are prompted to browse for and select the appropriate active report.

(If a Resources folder is selected.)

Add an image held on the clipboard as a resource of the selected Category, Topic or
Document.

(If a diagram image resource is selected.)
Open the View Image window, containing an image of the selected diagram.

Alternatively, double-click on the image name.

(If an image resource is selected.)

Copy the image or diagram image to the clipboard.

Refresh the currently-open Category, Topic, Document or Comment, getting new
Comments, Documents and Topics that other users might have created.

However, if you open a different Category, Topic or Document the Library window
always displays the latest information from the database.

Alternatively, click on the 'Refresh' icon in the window toolbar.

Reload the entire Library connection, getting new Categories, Topics and
Documents.

Assign or clear a status marker against the selected Category, Topic or Document;
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Review Status

Bind to Project Browser
Package

Security Options

Connections...

Options...

Delete Category 'xyz'
Delete Topic 'xyz'
Delete Document 'xyz'
Delete Resource 'xyz'

Delete Comment 'xyz'

(c) Sparx Systems 2025

2 September, 2025

you can mark the item as:
e  Awaiting Approval

e Approved

e Rejected

Or clear the marker (None).

Bind the selected Topic to a Package in the Browser window, so that Review
Documents created in the Specification Manager for that Package are automatically
stored in the Topic.

When you select this option, the 'Select Package to Bind' dialog displays, on which
you browse for and select the Package to bind the Topic to.

Access one of three options:
e 'Apply Password Lock' - to display a prompt to enter a security password

e 'Unlock for Editing' - to display a prompt to enter the set password so that you
can edit the item

e 'Remove Password Lock' - to display a prompt for the set password, which is
then removed

When you set the password, an exclamation mark icon is added to the Category,
Topic or Document name.

Access other Model Libraries from other Enterprise Architect models or models
located on servers.

Alternatively, click on the drop-down arrow in the 'Connection Options' field in the
window toolbar, and select one of the listed models.

Use the '<Configure Connections™>' option to add and connect to additional Model
Libraries.

Change the loading behavior of the Library window.

Delete this Category, Topic, Document or Comment and all sub-topics and
sub-documents, or delete the resource attached to the item.

Alternatively, click on the item and press the Delete key.

A confirmation dialog displays; click on the Yes button to remove the item and any
dependent items from the Library window.
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Add a New Category

You can add new Categories to the Library window, in which to store related Topics and Documents.

Access
Ribbon Start > Collaborate > Model Library
Keyboard Shortcuts Ctrl+Alt+U

Create a Category

Step Action

1 Right-click on a blank area in the Library window and select the 'New Category' option.
A new 'Category' icon displays in the hierarchy.

Team Review nx

fﬁ 2 || <Cument Model> v,O|

i [ Formal Reviews

= ew Category]

i+ g Mot From SM
[ SpecMan

2 Overtype the New Category text with the name of the Category, and click off the name.

The Category description editor displays in the 'Team Document' tab; type the appropriate Category
description, if required.

3 Add new Topics and/or resources to the Category.

Create a Category - Alternative

Step Action

1 Right-click on a blank area in the Library window and select the 'New Category from template' option.
A new 'Category' icon displays in the hierarchy.

2 Overtype the New Category text with the name of the Category, and click off the name.
The "New Category from Template' dialog displays.

3 Click on the '"Template' drop-down arrow and select a predefined template for the Category description.
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Click on the OK button.

4 The Category description editor displays in the "Team Document' tab; type the appropriate Category
description, if required.

5 Add new Topics and/or resources to the Category.
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Add a New Topic

In the Library window you can add new Topics to a Category, in which to store related Documents and their Comments.

Access
Ribbon Start > Collaborate > Model Library
Keyboard Shortcuts Ctrl+Alt+U

Create a new Topic

Step

1

Action

Either:

e Right-click on the required Category name in the Library window and select the 'New Topic' option
e  C(Click on the Category name and click on the "New Topic' icon in the Library window toolbar, or

e  Click on the Category name and press the Ctrl+N keys

A new 'Topic' icon displays under the Category name.
Overtype the New Topic text with the name of the Topic, and click off the name.
The Topic description editor displays in the 'Team Document' tab; type the appropriate Topic description,

if required.

Add new Documents and/or resources to the Topic.

Create a new Topic - Alternative

Step

1

Action
Right-click on the required Category name in the Library window and select the New Topic from
Template' option.

A new 'Topic' icon displays under the Category name.

Overtype the New Topic text with the name of the Topic, and click off the name.
The New Topic from Template' dialog displays.

Click on the '"Template' drop-down arrow and select a predefined template for the Topic description.
Click on the OK button.

The Topic description editor displays in the 'Team Document' tab; type the appropriate Topic description,
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if required.

5 Add new Documents and/or resources to the Topic.

Notes

e Ifyou already have the 'Team Document' tab open, the 'New Topic from Template' dialog displays as soon as you
select the 'New Topic from Template' menu option; you can click on and overtype the Topic name after you have
created the Topic description
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Add a New Document

Within the Library window, you can create a new Document on a Topic as either:
e A blank Document
e A Document based on a predefined template, or

e A Document from a file link

Access
Ribbon Start > Collaborate > Model Library
Keyboard Shortcuts Ctrl+Alt+U

Create a blank Document

Step Action

1 Either:
e Right-click on the appropriate Topic name in the Library window and select the New Document'
option

e  Click on the Topic name and on the New Document' icon in the Library window toolbar, or
e  Click on the Topic name and press the Ctrl+N keys

A new 'Document' icon displays underneath the Topic name.

2 Overtype the New Document text with the name of the Document, and click off the name.

The text editor displays in the 'Team Document' tab.

3 Type the text of the Document as required.

Create a Document based on a predefined template

Step Action
1 Right-click on the appropriate Topic name in the Library window and select the 'New Document from
template' option.

A new 'Document' icon displays in the hierarchy.

2 Overtype the New Document text with the name of the Document, and click off the name.

The 'New Document from Template' dialog displays.
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3 Click on the drop-down arrow in the 'Template' field, and select a predefined template for the Document
contents.
4 Click on the OK button.

The template structure is displayed in the 'Team Document' tab.

5 Type in or paste the text of the Document.

Create a Document based on a link to an external file

Step Action

1 Open a file browser (such as Windows Explorer) and locate the file.

2 Click on the file name and drag it onto the appropriate Topic name in the Library window.

A new 'Document’ icon is created underneath the selected Topic, and the body of the Document is shown
in the 'Team Document' tab.

A link to the source file is created at the start of the message.

3 Click twice on the New Document text in the Library window, and overtype the text with the name of the
Document.
4 In the 'Team Document' tab, create and edit text around the file link, and add further links if required.

When you have created the Document

You can Detail
Create links from the To elements and diagrams from the:
Document e  Browser window

e Model Search
e 'Views' tab of the Focus window, or

e Package Browser

Create links from the Such as:
Document to Library e Categories
objects

e Topics, and

e  Documents

Create links from the These links can be either in the text of the Document or on the Category, Topic or

Document to external files Document in the Library window (the link is added to the Model Links folder for
the Library item).

Add resources to the It is simple and convenient to link to the resources that are the subject of discussion
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Document or that illustrate points in the discussion.
Receive Comments on the The purpose of the Library window is to discuss aspects of development, so you
Document from other users can expect to receive Comments on the Documents that you have posted, and to

create Comments on the material posted by your colleagues.
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Comment on a Document

You use the Library window as a forum for discussion of items and issues within the project, so when you read a
Document on a particular point (or a response to that Document) you might want to respond with your own Comment.

You can create a Comment directly from the Document you are responding to, from material that you want to use as your
response, or from a predefined document template.

Access
Ribbon Start > Collaborate > Model Library
Keyboard Shortcuts Ctrl+Alt+U

Create a Comment in the Library

Step Action

1 Either:

e Right-click on the required Document (or Comment) in the Library window and select the New
Comment' option

e Click on the Document name and on the 'New Comment' icon in the Library window toolbar, or
e  Click on the Document name and press the Ctrl+N keys

A Re:<Documentname> entry displays underneath the Document you are replying to, and the cursor
becomes active in the 'Library' tab so that you can create and edit your response.

2 Type in, format and save the contents of the Comment.

Create a Comment from external material

Step Action

1 Open a file browser (such as Windows Explorer) and locate a file containing the material you want to use
in your response.

2 Click on the file name and drag it into the Library window, over the Document to which you are replying.
A prompt displays for you to specify whether to:

e (Create a new Comment containing the text of the file (the file name displays as the Comment name)
or
e Add the file to the original Document as a Model Link

3 If necessary, edit, format and save the contents of the reply.
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Create a Comment based on a predefined template

Step Action

1 Right-click on the appropriate Document name in the Library window and select the 'New Comment from
template' option.

A new 'Comment' icon displays in the hierarchy, and the New Document from Template' dialog displays.

2 Click on the drop-down arrow in the 'Template' field, and select a predefined template for the 'Comment'
contents.
3 Click on the OK button.

The template structure is displayed in the 'Library' tab.

4 Type in or paste the text of the Document.

When you have created the Comment

You can Detail
Create links from the To elements and diagrams from the:
Comment

e Browser window
e Model Search
e 'Views' tab of the Focus window, or

e Package Browser

Create links from the These links can be to related Libraries:
Comment to Library e Categories
objects

e Topics and

e  Documents

Create links from the These links can be either in the text of the Comment or on the parent Category,
Comment to external files Topic or Document in the Library window (the link is added to the Model Links
folder for the Library item).

Add resources to the It is simple and convenient to link to the resources that are the subject of discussion
Comment or that illustrate points in the discussion.

Receive replies to the The purpose of the Library window is to discuss aspects of development, so you
Comment from other users can expect to receive replies to the Comments that you have posted, and to create

Comments on the material posted by your colleagues.
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Protection Against Editing

When you have created a Library Category, Topic or Document containing text, the item text is exposed to change by
any user who has access to the Library window. You can protect the item against unrestricted changes by setting a
password on it. The password only refers to that item; to protect the text of Topics, Documents or Comments subordinate
to the item, you set a password on each of them as well.

When the password is set, only those users who have the password can edit that item, and only when they specifically
enter the password to unlock that item. Any other user of the Library window can still view the protected item.

The password does not protect the item from operations on the item as a whole, including being deleted.

Notes

e The use of a password on an item is indicated by an exclamation mark against the item in the Library window; a
blue icon indicates that a user with the password has opened the item, and a red icon indicates that the item is locked

e When you click on an item to set a password, the item opens; you can edit the item after you have set the password,
while it is still open

e Once a password-protected item is closed, any user who wants to edit the item must first select to unlock the item for
editing and then enter the password set on the item

e Unlocking is specific to the user; the item remains locked to other users until they enter the password themselves

e If the password becomes unnecessary, you can remove it from the item
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Edit an Item

When you have created a Category, Topic, Document or Comment, you edit the text within it using the Team Document
editor. This is based on the Document editor, which is used to edit report documents and Linked Documents throughout
Enterprise Architect.

You can also change the name of the item by selecting it, pressing F2 and typing the new name.

Access

Open the Library window using one of the methods outlined here, then double-click an item or select the item and press
the Enter key, to open the Team Document editor.

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Option Descriptions

The editor menu option descriptions are grouped according to the actions you are performing.

Actions
Creating and importing documents
Configuring the editor page display and formatting tools shown

Incorporating stylesheets, special texts and Tables of Contents

Managing the base styles in the Normal.rtf style template file

Moving through, searching and selecting text

Formatting characters and text strings

Formatting paragraphs and text blocks

Inserting tab points

Inserting sections, columns and page breaks, and repaginating

Inserting and editing page headers and footers, and footnotes and endnotes
Inserting tables

Inserting hyperlinks and bookmarks (including using the 'New', 'Link to Existing Element' and 'Hyperlink' options
on the 'Create' context menu)

Inserting images, OLE objects, frames and drawing objects
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Printer set up and printing documents

Check spelling and use of terms

Tracking, accepting and rejecting changes to the text
Protecting document text from accidental change

Create and refer to definitions of Glossary terms in the Project Glossary (using the 'Create | Glossary Definition'
context menu option)

Notes

e  To undo one or more immediately previous edits, press Ctrl+Z, or select the 'Layout > Diagram > Undo' ribbon
option; you can still undo a change even after you have saved the change

e To redo one or more immediately previous undone edits, press Ctrl+Y, or select the 'Layout > Diagram > Redo'
ribbon option
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Add Object Links

In the Library window you can create hyperlinks from a Document to any elements and diagrams that are associated with
it. This helps you to:

e Rapidly navigate to the objects in the Browser window

e  Access the element properties, and

e  Open a diagram directly from the Library window

You can also create links to:

e  Other Categories, Topics and Documents in the Library window

e [External files from a file browser

Facilities
Facility Action
Associate an element, Drag the object over the required Category, Topic or Document in the Library
diagram, external file or window, from the:
Library item with a e Browser window
message
e Package Browser
e 'Views' tab of the Focus window
e Model Search window or
e External file browser
To create a link to another Library window item, press Ctrl as you drag that item
over the required Category, Topic or Document.
If it does not already exist, a Model Links folder is created under the selected
Library item, and the link to the dragged object is added to the folder.
Associate an external file From any browser, click on and drag the file name into the text of the message.

with the message text The filename becomes a link to the file; click on it to display the contents of the

file.

The external file name also becomes a link to the file within the message when you
drag the filename onto a Topic to create a Document.

Review Options
To review an object in the Model Links folder, right-click on the object to display the navigation context menu.
Option Action

Open Open the linked diagram or external file.

Alternatively, double-click on the diagram link.
Properties Display the 'Properties' dialog for the selected element or diagram.

Alternatively, double-click on the element, attribute or operation link to open the
'Properties' dialog of the object.
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Create (Edit) Linked Either:
Document e  Open the 'New Linked Document from Template' dialog, to begin creating a
new Linked Document on the element, or
e Open the 'Linked Document Editor' to change an existing Linked Document

Find in all Diagrams Open the diagram in which the element is used, or display a list of several diagrams
in which the element has been used.

Find in Project Browser Highlight the element or diagram in the Browser window.

Locate Item Highlight, in the Library window, the Library item linked to the message.
Alternatively, double-click on the link in the Model Links folder.

Delete Model Link Delete the association between the Document and the object.
<name>
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Library Resources

Whilst having a discussion through the Library window, it is convenient to link to the resources that are the subject of
discussion or that illustrate points in the discussion. Such resources include:

o XMI files of Packages within the current project
e  Active Profiler reports

e Images of currently-active diagrams

e Images currently captured on the clipboard

e Bookmarks to currently active websites

You can link to such resources from Category or Topic notes, or from a Document. The resource links are created in a
Resources folder underneath the selected Category, Topic or Document, as shown:

EI 2 Diagrams
= )| Elements
= _,ﬂ RE:Elements
= H Resources
...... *_'i Timing
- [&] Data Model

Access

Open the Library window using one of the methods outlined here, then;
Right-click on <object> | Share Resource | <resource type>

You create the Resources folder by creating a link to a resource underneath the selected Category, Topic or Document.
Similarly, you delete the Resources folder by deleting the last resource within it. Having added a resource, you can
right-click on it and use a further context menu to:

e Re-import the Package XMI files to the model or
e Display the images

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U
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Search Library

The Library window provides the facility to search the titles of all Library items, to locate items referring to a specific
subject.

Search the Library

Step Action

1

#

In the Library window toolbar, click on the (Search) icon.

The search panel displays underneath the toolbar.

2 In the blank field, type the text string to search for.

3 If required, select the 'Match Case' checkbox to locate text with the same case as the search string.

4 If required, select the 'Match Whole Word' checkbox to locate only complete words that match the search
string.

5 Click on the Find button.

The search locates the first instance of the search string in the title of a Category, Topic, Document or
Comment, and displays the contents of that item in the Library window.

6 To locate further instances of the text string, click again on the Find button.

7 To close the search panel, click again on the 'Search' icon in the toolbar.
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Library Options

You can change the loading behavior of the Library window, using the 'Library Server Options' dialog. If you change the
settings, the new loading behavior is not applied until you restart the Library.

Access

Open the Team Documents window using one of the methods outlined here, then right-click in the Team Documents
window and select 'Options'.

Ribbon Start > Collaborate > Model Library
Keyboard Shortcuts Ctrl+Alt+U
Library Options
Option Action
Preload items less than Type the threshold item size (in KB) below which the items will be preloaded and

above which item data is only loaded when selected.

Load item data when The fastest loading option. Library window data is only loaded on demand; for
required example, when you read a Document.
Preload all data Caches the entire contents of the Library on load; this takes longer to load but, once

completed, navigating the Library window is faster.
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Library Connections

If you are modeling in a different model from the rest of your team, you can switch to Libraries from other Enterprise
Architect models, including models located on servers. This connects only to the Library for the selected model; it does
not change the model open in the Browser window or anywhere else in the system.

Access

Open the Team Documents window using one of the methods outlined here, then either:
e Right-click on the Team Documents window and select 'Connections', or

e  Click on the 'Connection Options' drop-down field and choose 'Configure Connections'

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Switch to another Library

Step Action

1 Open the Team Review Connections screen.

If the required model is not listed, click on the '<Configure Connections>' option; the 'Team Documents
Server Connections' dialog displays.

Team Documents Server Connections

Connection

Target

Connections New Delete

Default MName

b =Current Model>

Go to Step 3.
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2 Alternatively:

Right-click anywhere in the Library window and select the 'Connections' option; the "Team Documents
Server Connections' dialog displays.

In the list in the 'Connections' panel, select the checkbox against the appropriate model name to connect to
the Library for that model, then click on the Open button.

The connection now switches to the Library in the selected model.

If the required model is not listed, go to Step 3.

3 Select the appropriate type radio button and click on the New button.

e For a project file, a browser dialog displays through which you can search for and select the
appropriate model

e For a model in an ODBC DBMS data repository, the 'Microsoft Data Link' dialog displays, through
which you can locate and connect to the repository

e For amodel in a DBMS data repository, the 'Open Server Connection' dialog displays, through which
you can locate and connect to the repository

4 When you have selected and opened or connected to the required Enterprise Architect model, and returned
to the 'Team Documents Server Connections' dialog, the model name displays in the 'Connection Name'
field and in the 'Connections' panel.

5 Select the checkbox against the model name and click on the Open button to connect to the Library for

that model.

The Library window now shows the discussions in the selected model.

Fields/Options on the 'Team Documents Server Connections' dialog

Option Action
Connection Verify the name of the selected model.
Target Verify the path to the selected model.
New Click on this button to display the list of connection types you can select as the first

step in identifying the model for a new Library connection.

Delete Click on this button to delete the currently selected connection from the
'Connections' list. There is no confirmation prompt; the connection is immediately
removed from the list.

Connections View all Library connections created; click on the checkbox against the required
connection.

Open Click on this button to switch the Library to the selected connection and to close the
dialog.
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The Model Calendar

The Project Calendar provides a project management overview in calendar format of the deployment of resources,
timeframes for tasks, and upcoming project events such as meetings and milestones. The calendar displays in the
Diagram View workspace, consisting of a:

e (Calendar panel, displaying months of the year
e Diary panel sectioned into days or weeks

e  Toolbar at the top of the window, which enables you to define what information is displayed and how it is formatted

Access

Ribbon Start > Collaborate > Calendar

Features

Screen area Description

Calendar Panel The Calendar panel, when viewed normally on the screen with other windows and
panels, displays a calendar of three months that by default includes the current
month.

By closing or reducing other windows and panels on the screen, and depending on
the size of your screen, you can show the months for a longer period, to a maximum
of 3 years and six months.

You can review data going back over a long period, and plan ahead well into the
future; these periods can theoretically span ten years or more, if required. To
display future or past months, either:

e  Click on the arrows in the names of the months on the left and right of the top
row of months, or

e  (Click and hold the mouse on the name of a month so that a list of months and
years displays, then move the mouse forwards to scroll up the list or backwards
to scroll down the list; when you reach the required month, ensure that it is
highlighted and release the mouse button

On the calendar, today's date has a red border; if you have scrolled the calendar so

that today's date is not shown, click on the second icon in the toolbar (i:l) to
position the current month in the top left of the calendar with today's date
highlighted.

Diary Panel The 'Diary’ panel displays a set of day fields, each of which can contain one or
more markers for an event or task.

The content of the display is determined by the selections you make in the toolbar,
and principally by the object type you select from the first drop-down field:

e  Project Calendar
e Allocated Resources
e Project Tasks

The structure of the display depends on the period you want to review, specified
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using the icons on the toolbar:

e | day (Project Calendar only)

e 5days (Mon - Fri) (Project Calendar only)
e 7 days (Mon - Sun)

e 3] days

However, in the 'Calendar' panel you can highlight specific periods of between 1
and 7 days (Project Calendar only) and 14, 21, 28, 35 and 42 days, to display just
those periods in the 'Diary’ panel.

If you select a period of between 1 and 7 days, each day is divided into one hour
time intervals; you can adjust the time intervals for these periods, using the toolbar.

For the current day, the current time is also highlighted.

Also, if you click on today's date in the 'Calendar' panel the Diary panel' changes to
show the shortest period (7 days or 1 day) for the object type, again with adjustable
time intervals for the times of day.

For displays of 7 or more days, you can scroll up or down to display the
information for earlier or later dates; if you scroll away from today's date, you can
return to it by right-clicking anywhere on the display and selecting the 'Show
Today' option.

The toolbar options modify what is displayed on the 'Diary' panel, and help you to
add certain kinds of information.

The icons and fields in the toolbar, from left to right, have these functions:
e Add New <object> - enables you to create a new record for an event or task

e  Show Today - re-focuses the 'Diary' panel and 'Calendar' panel on today's date,
for any object type

e 1,5,7,31 - sets the number of days displayed in the 'Diary’ panel

e  First drop-down - identifies the type of information to display: Calendar
events, allocated Resources, or Tasks

e Second drop-down - identifies the type or characteristic of object to filter for
(and depends on the value selected in the first field)

e  Third drop-down - identifies the subtype of event, such as Planning Meeting or
People off sick or, for Allocated Resources, the element type to filter for

e Options:

- Configure Event Subtypes - displays the 'Configure Subtype' dialog,
which you use to define categories of event to record on the Calendar

- Time Scale - where the display includes times of day; enables you to
reset the time interval to numbers of minutes

- Show End Time - for the Project Calendar, where the times of day
are NOT shown and an event occurs within one day, this shows or
hides the time at which the event finishes (the start time displays
automatically)

- Show Time As Clocks - toggle between showing start and end times
in digital format and as a clock face

- Compress Weekend Days - in 31-day format, toggle between showing
Saturday and Sunday as separate fields and a pair of half-fields

- Show ToolTips - toggle between showing and hiding mouse
roll-over tool-tips
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e The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect

e In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them
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Calendar

Project Calendar is a display mode of the project Calendar facility. In Project Calendar mode, the 'Diary' panel shows a
selected period of time containing flags for each event that takes place in or through that period. These events can be, for
example, meetings, staff absences or commitments, product releases or public holidays.

You can customize the range of events that you record, using the 'Configure Subtype' dialog.

Access

Ribbon Start > Collaborate > Calendar > Project Calendar

Record an event in the Project Calendar

Step Action

1 Double-click on the required day, or the first day in a longer period.

The "Project Event' dialog displays.

2 In the 'Subject’ field, type the name of the event.
3 If the event is to take place at a specific place, in the "Location' field type the name of the place or room.
4 In the 'Category' field, click on the drop-down arrow and select the appropriate categorization:

e Event (such as an external trade show, or internal presentation)
e  Meeting (whether internal or external)
e  Milestone/Objective (such as a product test or release)

e People (an absence or commitment of a specific staff member)

5 If the event is likely to occupy one complete day, select the 'All day event' checkbox; this:
e  Places the event icon at the top of the day field in the Diary, above any time sections

e Hides the time sections of the 'Start time' and 'End time' fields

6 In the Start time and End time fields, specify the start and end dates and/or times of the event.
In the date section of each field, either:
e  Click on the drop-down arrow to display the current month and select the month and date, or

e  Click on the 'spin' arrows to roll the date forwards or backwards by one day at a time

In the time section of each field, click on the hour or minute components (which are separate) and either:
e Type in the required time or

e  Click on the 'spin’ arrows to roll the time backwards or forwards

7 In the 'Event Type' field, click on the drop-down arrow and select an appropriate type label for the event;
the options change depending on the value you selected for the 'Category’ field.
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This provides the fill color for the event icon, as indicated by the fill box next to each option.

8 In the 'Defined as' field, click on the drop-down arrow and select the indicator for whether the event is
internal or external to your organization.

9 If the event consists of a telephone call, select the 'Phone Call' checkbox.

10 In the description field, type any notes required on the event; these display in the mouse roll-over tool-tip
for the event on the 'Diary' panel.

11 If this event repeats at regular intervals, click on the Recurrence button and complete the 'Event
Recurrence' dialog.

12 Click on the OK button to save the event and display it on the Calendar.

Define a recurring event

Step Action

1 In the 'Start' and 'End' fields, specify the start and end times of the event; click on the hour or minute
components (which are separate) and either:

e Type in the required time or

e Click on the 'spin' arrows to roll the time backwards or forwards

2 In the 'Duration' field, click on each of the day(s), hours and minutes portions and either type or 'spin' to
the required value.

The hours and minutes portions are linked to the 'Start' and 'End' fields, so that:

e Asyou edit the 'Start' field or the 'Duration’ field, the 'End' field adjusts to maintain the duration
relative to the start time

e Asyou edit the 'End' field, the 'Duration’ field changes to match the difference between the start and

end times
3 In the 'Recurrence pattern' panel, select the appropriate radio button for the frequency of the event.
As you select the radio button, the fields on the right of the panel change to further define when the event
recurs.
4 Select the appropriate radio buttons and field values, with this guidance:

e Daily can be every 1, 2, 3, 4, 5 or 6 days, or every day of the working week

e Weekly is on one or more specific days of the week, the events being separated by a period of
between 1 and 51 complete weeks

e  Monthly can be on a specific date or a specific day of the month, the events being separated by a
period of between 1 and 11 complete months

e Yearly can be on a specific date or a specific day of a specific month

5 In the 'Range of recurrence' panel, in the 'Start' field, specify the date on which the event cycle begins.
Click on the day, month and year components (which are separate) and either:

e Type in the required value or
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e  Click on the 'spin' arrows to roll the date backwards or forwards

6 Select the appropriate radio buttons to indicate that the recurrence cycle:
e Has no defined end point
e Ends after a specific number of occurrences of the event (type in the number)

e Ends by a specific date (enter the date)

7 Click on the OK button, and again on the 'Project Event' dialog.

The event icon displays at all points in the Calendar where it is scheduled to occur, as defined in the
'Event Recurrence' dialog; the recurrence is indicated by a graphic depicting two recirculating arrows.

8 If the recurrence is no longer required:
e Double-click on the icon for any occurrence of the event, to display the 'Project Event' dialog
e Click on the Recurrence button to display the 'Event Recurrence' dialog
e  (Click on the Remove Recurrence button; the 'Event Recurrence' dialog closes
e Click on the OK button; the 'Project Event' dialog closes

Only the first occurrence of the event remains in the Calendar.

Notes

e The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect

o In these Editions, if security is enabled you must have 'Manage Project Calendar' permission in order to create,
update or delete Project Calendar events; if security is not enabled, you can change data without this permission

e In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them

®  You can transport a calendar of defined events between projects, using the 'Settings > Model > Transfer > Export
Reference Data' and 'Tmport Reference Data' ribbon options
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Configure Event Subtypes

The 'Configure Subtype' dialog enables you to define additional types of event to record on the Project Calendar, such as:

Access

Ribbon

Define a new event type within a select event category
Change an existing event type

Delete an existing event type

L

Start > Collaborate > Calendar : L5257 | Configure Event Subtypes

Manage the event types for your project

Step

1

Notes

Action

On the 'Configure Subtype' dialog, in the 'Category’ field, click on the drop-down arrow and select the
appropriate category for the event.

Click on the 'Type' field and type a suitable name for the event type (or select an existing event from the
list under the 'Category' field).

In the 'Color field, click on the drop-down arrow and select or define a color for the event icon.

Click on the Save button to save the new or edited event type to the list for the specified category.

Click on the New button if you are going to create another event type.
If the event type is no longer required, click on the Delete button.

If required, you can change the sequence of the event types in the displayed list, using the 'Up Hand' and
'Down Hand' buttons at the bottom of the dialog.

Click on the OK button to close the dialog; any new event types are available for use in the Project
Calendar.

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have
'Manage Project Calendar' permission in order to create or delete Project Calendar event subtypes; if security is not
enabled, you can change data without this permission

You can transport your defined event types between projects, using the 'Settings > Model > Transfer > Export
Reference Data' and 'Tmport Reference Data' ribbon options
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Allocated Resources

'Allocated Resources' is a display mode of the project Calendar facility, that you can use to:
e Review the allocation of resources across the project over a period of time

e Review the status of the work assigned to those resources

e Display and edit the details of the task assigned to a resource

e  Allocate further resources to an element

e Delete a resource allocation from an element

e Create and send an email to the resource allocated to an element

In 'Allocated Resources' mode, the 'Diary’ panel shows the selected period of time (see the Project Calendar topic), with
at least one icon representing each element in the project to which a resource has been allocated during that period. If an
element has more than one allocated resource, each element:resource combination is represented separately.

Each icon shows the element name and resource name, and indicates the status of the assigned work with one of these
symbols:

e a green square, indicating that the resource has been assigned the work
e agreen tick, indicating that the resource has completed the assigned work
e ared square, indicating that the resource has not completed the assigned work

e asquare divided diagonally with green and red halves, indicating that the assigned work is to be completed within
one working day

Typically, while the work is in progress a resource is represented by:

e Anicon with a green square on the day the work is planned to start, and
® Anicon with a red square on the day the work is planned to finish
When the work is complete, the icons on both days display the green tick.
Resources are initially allocated to elements through the:

e Resource Allocation window, or

e 'Allocated Work' tab of the Personal Tasks window

You can then edit these allocations through either of those windows or through the Allocated Resources Calendar itself.

Access

Ribbon Start > Collaborate > Calendar > Allocated Resources

Allocate Resources

Option Action

Display/edit details of an Either:
allocated resource e Double-click on any icon for that element:resource combination, or
e Right-click on the icon and select the 'Properties' option

The 'Assigned Resources' dialog displays, showing the details of the assignment of
the resource to a task on the element.
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This dialog has the same content, format and functions as the Resource Allocation
window, in Item mode.

Right-click on any icon for the element and select the 'Assign Resource to <element
name>' option.

The 'Assigned Resources' dialog displays, showing the start and end dates both set
to the date from which you selected the icon, and the 'Allocated Time' field set to
'1"; all other fields are blank.

This dialog has the same content, format and functions as the Resource Allocation
window, in Item mode.

Specify the resource and the role or task that resource is performing, and define the
period for which the resource is allocated to the element.

Right-click on any icon for the element:resource combination and select the
"Message Resource <resource name>' option.

The 'Model Message' dialog displays, on which you create and send your message
to the resource allocated to the element.

Right-click on any icon for the element:resource combination, and select the Delete
Resource from <element name>' option.

A prompt displays to confirm the deletion; click on the Yes button.

The icon and any corresponding icons for that element:resource combination are
deleted from the calendar, and the resource is no longer allocated to that element.

Right-click on any icon for the element, and select the 'Find in all Diagrams' option.
If the element is used in only one diagram, that diagram displays.

If the element is used in more than one diagram the 'Element Usage' dialog
displays, listing the diagrams in which the element occurs.

Select the required diagram and click on the Open button to display that diagram.
This option also operates on Port and Part Property Type Classifiers.

Right-click on any icon for the element, and select the 'Find in Project Browser'
option.

The area of the Browser window containing the element is brought into focus and
expanded, and the element is highlighted.

Firstly, click on the end date icon for the element:resource combination to highlight
it; the corresponding start date icon is also highlighted.

If the start date icon is not in view, right-click on the end date icon and select the
'Show Start/End' option; the display scrolls to show the start date and the start date
cell is highlighted.

Firstly, click on the start date icon for the element:resource combination to
highlight it; the corresponding end date icon is also highlighted.

If the end date icon is not in view, right-click on the start date icon and select the
'Show Start/End' option; the display scrolls to show the end date and the end date
cell is highlighted.

Right-click anywhere on the display and select the 'Show Today' option.
The display returns to today's date, which is highlighted and outlined.
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Notes

e  The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect

e In these editions, if security is enabled you must have 'Configure Resources' permission in order to allocate
resources to or remove resources from the Project Calendar; if security is not enabled, you can change data without
this permission

e In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them

e As the start and end icons for a completed task are identical, and one-day tasks have only one icon, the methods to
show the corresponding start date or end date for an icon are also useful to show whether the icon is for a start or end
date, or for a one-day task; alternatively, double-click on the icon and review the allocation dates
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Project Tasks

Project Tasks is a display mode of the project Calendar facility, that you can use to:
e Review the tasks across the project over a period of time

e Review the progress of those tasks

e (Create new tasks

e Display and edit the details of the task

e Allocate a resource to a task

e Delete a task

e Create and send an email to the resource assigned to a task

e C(Create and send an email to the owner of the task

In Project Tasks mode, the 'Diary' panel shows the selected period of time (see the Project Calendar topic), with at least
one icon representing each project task scheduled during that period. The icon represents an independent record of the
task - there are no comparisons or validations of the tasks. Therefore you can have separate icons for the same task, with
different resources allocated or no resources allocated; you can even have identical task records, if these serve a purpose
for you.

Each icon shows the task name and resource name, and indicates the status of the task with one of these symbols:
e agreen square, indicating that the task has been scheduled

e a green tick, indicating that the task is complete

e ared square, indicating that the task is incomplete

e asquare divided diagonally with green and red halves, indicating that the task is to be completed within one working
day

Typically, while a task is in progress it is represented by:

e Anicon with a green square on the day the work is planned to start, and

e Anicon with a red square on the day the work is planned to finish

When the work is complete, the icons on both days display the green tick.

Tasks can be created and managed through this view of the Project Calendar, or the:
e  Project Tasks view for the whole project, or

e 'Project Tasks' tab of the Personal Tasks window

Access

Ribbon Start > Collaborate > Calendar > Project Tasks

Manage Project Tasks
Option Action

Create a task Either:

e Double-click on the date cell in which the task is to start, or
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e Right-click on the cell and select the 'Add New Task' option, or

e  (Click on the down-arrow next to the first icon in the Calendar toolbar, and
select the 'New Task' option

The 'Task Details' dialog displays, through which you create the task.

Either:
e Double-click on the task
e Right-click on the cell and select the 'Properties' option, or

e  (Click on the down-arrow next to the first icon in the Calendar toolbar, and
select the 'Properties’ option

The 'Task Details' dialog displays; if necessary, edit the information.

Certain tasks might not initially be assigned to a resource, but might later require
specific assignment to finish them off.

Open the task to edit it, click on the drop-down arrow in the 'Assigned' field and
select the required resource.

Right-click on any icon for the required task and select the 'Delete <task-name>'
option.

You are prompted to confirm the deletion; click on the Yes button.

Right-click on any icon for the task and select the 'Message Owner' option.

The "Model Message' dialog displays, on which you create and send your message
to the user who owns the task (as identified in the 'Task Details' dialog).

If the task does not have a defined owner, this option does not operate.

Right-click on any icon for the task and select the 'Message Assigned <resource
name>' option.

The 'Model Message' dialog displays, on which you create and send your message
to the resource assigned to complete the task (as identified in the 'Task Details'
dialog).

If the task does not have a defined resource, this option does not operate.

Firstly, click on the end date icon for the task to highlight it; the corresponding start
date icon is also highlighted.

If the start date icon is not in view, right-click on the end date icon and select the
'Show Start/End' option; the display scrolls to show the start date and the start date
cell is highlighted.

Firstly, click on the start date icon for the task to highlight it; the corresponding end
date icon is also highlighted.

If the end date icon is not in view, right-click on the start date icon and select the
'Show Start/End' option; the display scrolls to show the end date and the end date
cell is highlighted.

Right-click anywhere on the display and select the 'Show Today' option.
The display returns to today's date, which is highlighted and outlined.
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e  The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect

e In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them
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Collaboration Support in Diagrams

Enterprise Architect provides a simple yet extremely useful facility to notify you immediately via the current diagram
when any Discussion postings are made concerning elements on the diagram, or when Chat postings are made to you by
specific users or groups. Having seen the notification, you can click on it to get instant access to the conversation,
without having to establish who sent the message, on what element, or by what means. Two applications of this facility
are:

®  You can set up a diagram that monitors Chats with your team members or other regular project contacts (each
represented by an Actor element), notifying you of any Chat messages from each of them and allowing you to
immediately respond to each message without having to establish connections in the Chat & Mail window; you
could display this diagram as a floating diagram parked in a convenient section of your work area

®  You can work on and discuss elements in the diagram and maintain the conversation without having to re-establish
focus in the Discuss & Review window and in the diagram with each exchange

As an additional boost to your work, a context menu is available against each element on any diagram, containing
options that give you instant access to the tabs of the Discuss & Review window, Chat & Mail window and the 'Model
Message' dialog.

A different icon ( @) could be shown against one of your Chat correspondents on the diagram, if you don't have an
unread Chat message; this indicates that the user is currently in a Chat conversation with you, or was the last person to
send you a Chat message.

There are three steps in the process of setting up Collaboration Support in a diagram:

e (Create/open and populate the diagram in which you will be working and/or monitoring for new Discussion or Chat
posts

e Set a flag on elements in the diagram and on Chat user groups to monitor for messages (not required for messages
from individual users)

e  Set a value for the 'Support Collaboration' option in the diagram "Properties’ dialog or Properties window

Set Up Diagram

If you want to monitor Discussions on elements that you are working on in a diagram, you can do so in any type of
diagram containing any type of element. Simply create or open the appropriate diagram and add and/or configure the
required elements.

If you want to monitor Chat messages from certain people (team members, other project groups, internal stakeholders;
anyone who is defined in User Security as a user or member of a user group) you add an Actor element to the diagram
for each one of those people or groups. In theory you could add the Actor to any diagram that you might be working in,
but it is far more practical to hold all your 'Collaboration' Actors in one separate diagram (a Use Case diagram for
preference) that is always available to monitor receipt of messages during the day.

In either case:

1. Create/open the diagram and add to it the required number of Actor elements (perhaps use the '"Add Multiple
Elements' facility - see the Add Multiple Elements Help topic).

2. Give each Actor element the name of the security user or user group it represents.

For each Actor element, in the 'Alias' field of the Properties window, type the user ID of the user that the element
represents. If the Actor represents a user group, give the group ID the prefix group :: - for example:
group:: LOB_analysis

4. Ask each user to place a user lock (or, for a user group, a group lock) on their Actor element, to allow 'locking user'
identification of the element during the monitoring process. This also gives the user ownership of the Actor element
for other purposes, and provides a level of security for their communications with you.

Your discussions diagram might resemble this:
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The diagram contains three individual users, a user group, and an element against which discussion items can be raised.

Set Monitoring On

In order to display a notification whenever a user posts to a Discussion thread on an element, or to a group Chat with
you, you need to first set the 'Monitoring' flag on the appropriate elements and/or Chat User Groups.

To set up monitoring for Discussions on elements, right-click on the element in the diagram and select the 'Collaborate |
Monitor Discussions' option. For further information, see the Discussions Help topic. You must also set the interval
between checks for new messages, as part of this process.

To set up monitoring for Chat User Groups, display the 'Chat' tab of the Chat & Mail window, click on the options icon
in the top right corner, select the "Monitor Groups for New Messages' option and select the User Group to monitor. For
further information see the Model Chat Help topic. You must also set the interval between checks for new messages, as
part of this process.

Messages sent to and from Chat threads with individual users (User Chats) are automatically monitored and display a
notification without a flag specifically being set.

Set 'Support Collaboration' on the Diagram

The third step for enabling Discussion and Chat notifications on a diagram is to provide a value for the 'Support
Collaboration' option in the diagram "Properties' dialog or Properties window. Either:

e  Open the diagram, right-click on the background, select the 'Properties' option and, on the 'Properties' dialog, select
the 'Element' tab; at the bottom right of the tab is the 'Support Collaboration' option, or

e  Click on the open diagram or the diagram name in the Browser window and, in the Properties window, locate the
'Support Collaboration' option at the bottom of the 'Appearance' section

Click on the drop-down arrow and select a value.

e Select None' to turn off Collaboration Support on the diagram for both Discussions and Chats, so no notifications of
messages will be shown on the diagram

e Select any other value to activate Collaboration Support for Discussions; any element for which a Discussion

message has been posted that you have not yet displayed will show a q notification icon off the top left corner
e The other values operate on Actor elements that represent the project members and groups defined in User Security;

when a Chat message is received by you from another project member, a [ notification icon displays on the
diagram to the right of the Actor element representing that person

e  Select "'With Alias' to check the Actor elements to locate the one that has the poster's user ID or group ID in the
'Alias' field; the Chat notification icon is displayed against that Actor element

e Select 'With Locking User' to check the Actor elements for the one that has been locked under the poster's user ID or
group ID; the Chat notification icon is displayed against that Actor element

e Select "'With Both' to check both characteristics of the Actor elements - firstly for the user ID that locked the element
and, if that is not found, for the 'Alias' field containing the poster's user ID

Click on the OK button to save the setting.

(c) Sparx Systems 2025 Page 117 of 119 Created with Enterprise Architect



Teams & Collaboration 2 September, 2025

The Support Collaboration Facility in Operation

Using the example in the Set Up Diagram section, let us suppose that Hugh has sent a Chat message to the person who is
currently logged in. In the diagram, that user sees the Chat notification icon appear against the 'Hugh' Actor element.

Team Meeting ltems:
Comments
Hugh

Heville George Authors

The icon displays against the element whether it is within the current Package or external to it.

If the 'Chat' tab of the Chat & Mail window is open, the owner can click on the Actor element to immediately display the
latest message on the tab, with the cursor positioned ready to create a reply to that message. If the 'Chat' tab is not
displayed, the owner can click on the notification icon, which will open the 'Chat' tab and show the Chat conversation,
again ready to enter a response to the message.

If the 'Team Meeting Items' element has a Discussion item posted against it, the element will show the Discussion
notification icon:

Team Meeting ltems:
Comments

Again, if the 'Discuss' tab is not displayed on the Discuss & Review window, clicking on the icon opens the tab ready to
continue the Discussion; if the tab is displayed, clicking on the element puts this Discussion in focus on the tab.

Context Menus

=
—
—

If you click on this icon, a short context menu displays with options that open the Discuss & Review window at the
'Journal', 'Discuss' and 'Review' tabs, respectively. The same options are also available via the right-click context menu,
'Collaborate' option.

You can therefore open out your conversations on an element to include Journal items and Reviews.

On the Mail icon, when you click on the 'Send Message' option and display the 'Model Message' dialog, it automatically
contains two hyperlinks - one to the selected element, and one to the diagram that contains the selected element. You
specify the recipients of the message, and those people can use the links to directly access the diagram and element under
discussion. The exception is if you have selected an Actor element with a user ID in the element's 'Alias' field; in this
case the message is automatically addressed to the user represented by the Actor, but does not automatically contain any
hyperlinks. You can simply send a message directly to the other user.
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